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1. Overview

Tap Forms is a one-of-a-kind database tool meant to organize anything in your life. Built on years of
development and user feedback, Tap Forms safely stores your information and provides a virtually endless
set of tools and customization options.

We like to think of Tap Forms as a digital filing cabinet for your movies, accounts, expenses, recipes, and
everything else in your life. It’s uses are only limited by your imagination. Much of what you add to Tap
Forms will be individual pieces of an overall collection – like a movie collection. Each movie is representing
by a “record”, which is comprised by that movie’s individual qualities or characteristics, represented by
“fields”. Tap Forms isn’t just for movies, though – anything you own, use, or need recorded can be dropped
into Tap Forms at a moment’s notice.

Because Tap Forms supports a wide variety of data entry options, it’s critical that you have the tools
necessary to best view and use your data. Throughout this guide, you’ll see articles spanning the entirety of
the Tap Forms experience, detailing how the features work and what they can be used for.

Ready to join the thousands of happy Tap Forms users? Purchase Tap Forms for Mac either directly or in
the Mac App Store. Tap Forms is also available for iOS in the App Store.

If you’re interested in spending time with Tap Forms before making the final purchase, you can do so by
downloading a free trial version. After you’ve completed the trial period, you’ll then need to purchase a
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license to use the app.

Last modified: Aug 26, 2018

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en

Page 5 of 158



2. Database Documents

Database documents are the containers for all the information you create in a particular Tap Forms
document. These contain all forms, records, and fields you’ve added, and can be imported, exported,
and opened at will. Database documents are made up of both an SQLite database file along with any photos
and file attachments.

For the majority of your Tap Forms usage, you will likely have few interactions with the ins and outs of
database documents; when you launch the app, you’ll simply choose which one you’d like to open and
continue working with your data inside the document. However, there are times where you’ll need to work
with database documents, either through migration, creation, deletion, etc.

To find the location of your documents, either select one and click the Show in Finder
button at the bottom of the list of documents, or you can find them here:
~/Library/Containers/com.tapzapp.tapforms-mac/Data/Documents
To get there:
1. Copy the above path.
2. In the Finder, press command-shift-g or click on the Go menu and select Go to Folder…
3. Paste the above path into the field.
4. Press the Go button.

*
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After launching Tap Forms, you’ll see the list of database documents you’ve created as well as the various
sample forms. Here, you can use any of the buttons found at the bottom of the window to interact with
database documents, including options to Add, Duplicate, Delete, Show in Finder, Send Document to
another device, and Show Document Info. To interact using any of these functions, select the database
document and choose one of the listed options.

As the foundation of Tap Forms, database documents are eligible for syncing and migration across
different versions of the app. Documents with sync properly set up will automatically display on the iOS and
Mac versions of Tap Forms, allowing you to work seamlessly and with updated copies of your forms
whenever necessary. And since database documents can be exported and backed up, you’ll always be able
to take your documents with you instead of needing to create new versions of your forms.

Database documents can also be locked and encrypted to protect any valuable data stored within them. To
do this, follow the instructions outlined in the Security topic.

Last modified: Jan 15, 2020
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3. Forms
In the “Forms” topics, you’ll receive an explanation of how forms work, what they are used for, and the pre-
built forms we’ve created to ease your early work in Tap Forms.

Forms

• What are Forms?
• Pre-built Forms

Last modified: Jun 07, 2018

3.1. What are Forms?
In Tap Forms, forms are the overarching categorization method used for the information you’re looking to
record. With forms, you’ll think about the big things you want to log – “Photo Library”, “Book Collection”,
“Cars” – and create individual items for each piece of your collection.

To create a form:

1. Click the + button at the top left of the window
2. Enter your form’s name and select an appropriate icon

Forms consist of records, which are the list of inclusions within your collection. If you were inputting your
book collection, for example, one record might be called “The Tipping Point”. These records do the
cataloging in Tap Forms – they’ll be the indicators for what you have saved.

But since you’re putting in the work to record information, you’ll likely want to add more than just the title of
something. That’s where fields come in; fields can have a variety of functions that provide in-depth
information about your records. For example, fields can contain text, photos, audio recordings, check boxes,
locations, notes, web sites, and more. By adding fields to your records – and, in turn, your forms – you can

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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log lots of useful data.

Forms are grouped by categories, which you’ll see on the left side of the window. Categories are used to
organize forms under specific headers, like “Home”, “Work”, etc.

With forms, you can customize how your data is displayed through sort options and view fields. If you need
your forms to do any calculations, you can define these rules, too.

Last modified: Jun 07, 2018

3.2. Pre-built Forms
To spark ideas and provide easy access to commonly used forms, Tap Forms offers 33 pre-built forms for
you to use or copy into your own form. Though it’s unlikely that these forms will encompass all your needs
within the app, their incorporation of fields can be a great launching point for your record-keeping.

The list of pre-built forms is found in the Sample Forms document under the All Forms dropdown menu.
The majority of forms will not contain any records, but will have relevant fields appropriate for the selected
form. Some forms will have records as examples of how you might be able to use the form.

Because the Sample Forms database document is aimed to be representative of what a typical set of forms
might look like, forms are also organized into categories and utilize fields and pick lists. This allows you to
see how the pre-built forms could be categorized should you import them into your own document.

If you’ve already created a database document, it will not feature any of the built-in forms. You can,
however, add any of the forms by following instructions outlined in the Exporting topic.

Below is a list of the forms that Tap Forms offers:

• Audio Dictation
• Business Accounts
• Calling Cards
• Client Call Log
• Clients
• Frequent Flyer Numbers
• Investment Accounts
• Software Licenses
• Bank Accounts
• Blood Donor Cards

On the iOS version the Sample Forms document is not installed by default. But you can
install them from the Documents view by tapping on the action menu button, then tapping
on Install Sample Files. An English version of the Sample Forms document as well as the
International versions of the Sample Forms document will be installed.

*
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• Credit & Debit Cards
• Daily Journal
• Driver’s License
• Email Accounts
• Health Insurance
• Home Inventory
• Homework Assignments
• Important Dates
• Passport Information
• Personal Health Cards
• To do
• Website Logins
• Garage Door Code
• Home Insurance
• Log Book
• Loyalty Cards
• Memberships
• My Movie Library
• Security Alarm Codes
• Serial Numbers
• Vehicle Insurance

Last modified: Feb 12, 2019

If you would like to use any of the sample forms within your own database document, you
can use the Export Tap Forms Archive or Export Form Template commands under the
File menu to save them to your drive. Then use the Import Tap Forms Archive or Import
Form Template commands to import them into your own document.

*
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4. Form Organization
In these “Form Organization” topics, we’ll discuss how categories and pick lists can help organize forms
and the ideas within those forms. Found in the same section of Preferences, these are two key
organizational tools.

Form Organization

• Categories
• Pick Lists

Last modified: Jun 07, 2018

4.1. Categories

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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Though forms tend to be the overarching categorization tool in Tap Forms, it’s also important that you are
able to find them as easily as possible. With categories, your forms live in a basic organizational structure
that you create – still in the sidebar, but each classified alongside similar forms.

To access the categories pane, you can either:

• Click Tap Forms Mac 5 in the menubar > Preferences > Lists > Categories
• Click Tools in the menubar > Edit Categories

Adding and Deleting Categories

When you’re in the categories menu, you’ll add categories via the + icon near the bottom of the window.
Once clicked, Tap Forms will prompt you to enter a title; when you’re finished, press the Return key to save
the category. To rearrange categories you’ve created, drag one above or below another. This change will be
reflected in the Forms sidebar.

Next to the + icon sits the delete (-) button, which will delete the currently selected category. This action
will permanently remove the category from Tap Forms, but will not delete the forms associated with the
category. In the event of an accidental deletion, you can simply recreate the category and re-add the forms.

After you’ve created forms, they’ll be added to the Forms List sidebar under the “Uncategorized” header. If
you have other categories, you’ll see those options above “Uncategorized”.

To change a category’s title, double click its name.*

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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When you have a form you’d like to add to a category, you can go about that in
two ways. Either:

• Tap on the form and open the Form sidebar. Below the name of the form, select your category from
the dropdown menu

• If one or more forms already belong to the category in the Forms List sidebar, drag the form from
“Uncategorized” to below the appropriate header.

Last modified: Apr 06, 2020

4.2. Pick Lists

For text and numbers fields, the typical input is through basic entry via the keyboard. However, for fields
with long or specific numbers, titles, labels, etc., pick lists offer the convenience needed to quickly
categorize your data. With pick lists, you can create a set of options that, when one is selected, can
populate a field. This eliminates the need to reference other records for spelling or previously created

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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options.

Pick lists are managed in the Preferences under the “Lists” tab, either accessible from the Tap Forms 5
dropdown menu in the macOS menubar or by navigating to Tools > “Edit Pick Lists…”.

Pick lists, which display in the small white area next to a field in a record, are assigned values either from
list or from field. From list values are ones that you’ll create based on what’s relevant to your field, like a
set of numbers or the various genres in your movie library. From field, on the other hand, uses values from
another form’s fields to assign values to the pick list.

There are six different styles of Pick Lists under the “Display As” column
heading.

1. Single Value Popover – This is the default style where Tap Forms will display a popover view that
allows you to select a single value.

2. Multi-Value Popover – A multi-value pick list will allow you to select more than one value to assign to

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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a field.
3. Combo Box – This gives you a popup button that also has a type-ahead text field as part of it. You

can type a value and Tap Forms will fill in the rest or you can click the arrow (or press the down arrow
key on your keyboard) to display a list of possible values.

4. Popup Button – This gives you a popup button that contains the list of values available. You can
select a single value from the popup button.

5. Checkbox Button – This provides a set of checkboxes in a grid format. The grid is determined by the
“Checkbox/Radio Columns” property in text and numbers fields and is a great tool for displaying
different options in different forms in the same way.

6. Radio Button – This is similar to the checkbox button option, but will instead display radio buttons.

After you’ve created your pick list, you’ll need to assign it to the appropriate text or number field. In the
Forms sidebar under the Field tab, select the field and navigate to the bottom of the sidebar. There, you’ll
see a dropdown menu to select your pick list. Pick lists can be assigned to one or more fields.

Use values from list:

To add a new value to the selected Pick List, click the + button beneath the values list.

If you have lots of values to add to a Pick List, it would be much quicker to click the Add Values… button
and type your new values into the popover that is displayed. You can even paste values into the popover if
you already have a list of values on your clipboard.

Use values from field:

You can also choose to get the values for your Pick List from another form’s field. To do that, click on the
Use values from field radio button, then select a Form and a Field.

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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Whenever you add records to the selected form and put values into the selected field, they will become
available to you in this type of Pick List.

To associate a Pick List with a field:

1. Click the form you want to edit.
2. Click the Form button in the toolbar.
3. Click the Fields tab.
4. Click the field that you’d like to assign the Pick List to.
5. Scroll to the bottom of the properties for the selected field and click the Pick List popup button.
6. Select the Pick List from the popup button.

You will now see the pick list button appear next to the field in the Default Layout, your custom layouts, and
the multi-column list view.

Last modified: Jan 31, 2021
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5. Fields
The following topics are about the all-important fields, which make records and forms the versatile
organizational tools they are. Throughout the topics are explanations on their utility and the ins and outs of
how they can be used.

Fields

• Field Types
• Editing Fields
• Calculations

Last modified: Jun 07, 2018

5.1. Editing Fields
With 25 fields, Tap Forms can be extraordinarily flexible for your data. However, when there are still field
configurations that you’d like to make to better serve your inputs, you can do so by editing field behavior.

First, you’ll need to add a field to your record. To do this:

1. Open the Form panel and click the “Fields” tab
2. Click the + button beneath the field list
3. Choose the field type
4. Provide the field title

For fields that have already been created, select one to edit its name, description, and label color.
Additionally, there are options to require the field during record creation and show the title on the list view,
both activated by a check box.

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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You can also move fields up and down to change how they appear on the Default Layout. To do that, just
click and drag the fields up and down and position them where you want them to be. The order they’re listed
in the Fields tab is the same order they’ll appear on the Default Layout.

To move fields on the multi-column list view so their column position changes, see the Multi-Column List
View topic.

While the above attributes will remain the same as you switch between field types, each field also features
its own unique set of settings that allow you to further customize its functionality. For example, the Number
field contains options for incrementation, number format, currency, and more. Through reviewing and
updating each field’s individual choices, you can better understand how the fields can work for you.

Last modified: Nov 14, 2018

5.2. Field Types
Tap Forms has 26 different field types. Each field type has its own set of properties that can be set in order
to customize the way Tap Forms displays and edits your data.

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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The following table describes all the field types available in Tap Forms.

Icon Field Type Description

Text
Text fields store small amounts of text. For
example, a text field might be a movie title
or short description.

Number

Number fields display numeric data. They
can be configured to format the display as
currency, decimals, percentages, scientific
notation, spell out (e.g. “twenty four ninety
nine”), or as a duration (e.g. “10 hrs, 3
mins” or “10:03”). Numbers are also useful
in calculations where you require a numeric
result.

Date

Date fields will display the month, day, and
year. The display format used depends on
your Region Format settings in the System
Preferences. In general, Tap Forms uses
the Medium date format to display dates.

Time

Time fields will display the hours and
minutes and AM or PM. This also depends
on your region settings. If you have
24-hour mode enabled, you will not see AM
or PM. Tap Forms uses the Short time
format to display times.

Date & Time

Date & Time fields are a combination of the
Date and the Time fields displayed in a
single field. The Date part will use the
Medium date format. The Time part will use
the Short format. By adding a Date & Time
field to your form, you can also enable the
Alerts function in Tap Forms. With the Alert
function, you can tell Tap Forms to notify
you at the specified date and time. You can
also include a short note which will be
displayed along with the notification. Alerts
can be scheduled to repeat at a variety of
frequencies. These options are available
when you’re editing a date value in your
record.

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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Date Created

Tap Forms keeps track of the date a record
was created. The Date Created field type
will expose this field to your forms. You can
sort or filter your records by this field.

Date Modified

Tap Forms also keeps track of the date
and time a record was modified. You can
sort or filter your records by this field.
Please note, however, that if you change
the sorting of your form after your form is
created, Tap Forms will update the Date
Modified value for each record to be the
current date and time.

Audio Recording

Tap Forms for Mac can play back audio
recordings made on Tap Forms for iOS,
but it cannot record audio notes on its own.
When you sync, Tap Forms for Mac will
gain access to the audio notes you created
on iOS.

Calculation

The Calculation field type lets you
construct formulas to compute
mathematical expressions. Formulas can
contain references to other fields within
your form. You can use all the basic
mathematical operators such as ( ) * / – +
as well as the keyword $now. The $now
keyword will insert the current time into the
formula before being evaluated.

Checkmark

The Checkmark field lets you have a basic
on/off toggle for setting whether something
is true or false, on or off, yes or no, etc.
Checkmark fields can be used in formulas
also. For example, if you wanted the total
to be computed only when a checkmark
field is on, just drag the checkmark field
into your formula and use multiplication to
cause the result to be either 0 if it’s off or
whatever the regular result would be if the
checkmark field value is on.

Contact
The Contact field lets you reference a
contact from your Mac’s Contacts
database. Tap Forms will copy the first and

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en
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last names into its database as well as the
contact’s unique identifier. This information
will be used to look up the contact’s record
from the Contacts database whenever you
click on the contact button to the right of
the field. Note: Due to the way Apple syncs
contacts across devices, the unique
identifier may change between devices.
This can cause Tap Forms to display the
wrong contact when you click on the
contact button to the right of the field.

Drawing

The Drawing field type on Mac is a read-
only field. You can create drawings on iOS
and view them on the Mac version. You
cannot draw into a field on the Mac
version.

Email

The Email field will give you a button to the
right of the field which will launch Mail
whenever clicked and pass the email
address entered into the field into the To:
field of a new email message. Separate
email addresses with commas to address
more than one email address at a time.

File Attachment

The File Attachment field will let you store
one or more files associated with your
record. You can tell Tap Forms if your File
Attachment field supports just one file or
multiple files by checking the Multi-File
Enabled checkbox on the Field Properties
screen. When Multi-File Enabled is
checked, you will see a list of files within
your File Attachment field. You can double-
click on a file to launch the app which is
responsible for that field type. You can also
choose to attach your file as a copy of the
file or as an alias of the file. When you
attach a copy, Tap Forms will copy the file
selected into the database. As the
database is synced, the attachments that
were copied into the database will also be
synced. You will then be able to access the
same files on your iOS devices and other
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Macs that are syncing the same database
document. Aliases cannot be viewed on
other devices nor synced.

Link to Form

This field lets you connect different forms
together in a parent to child relationship.
Use One to Many if you don’t want or need
to share the records from the linked form
with other forms or records. Use Many to
Many if you’d like to be able to select from
a list of previously entered records from
another form and link them to the parent
record. Use Join if you’d like Tap Forms to
manage the relationship between your
forms for you based on fields that match
between the parent and child forms.
Enable the Show Inverse Relationship
option if you want to display the parent
record on the child form you’re linking to.

Link from Form

The Link from Form field will display the
parent record that links to the child record.
This field should never be created on its
own. It is automatically created for you
from the Link to Form field when you
enable the Show Inverse Relationship
option.

Location

The Location field type will display a map
of your current location. You can search for
different locations and drag the pin around
to change your location. You can also edit
the location name, but Tap Forms will first
do an address lookup to fill in the address
that matches your current location.

Markdown

The Markdown field type allows you to
enter in large amounts of text using
Markdown formatting codes. See
https://www.markdownguide.org/basic-
syntax/ to learn about basic markdown
formatting codes.

Note
The Note field type allows you to enter in
large amounts of text. Text can also be
styled using different fonts, sizes, and
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colors. The Mac version has the ability to
add bulleted lists, but these are not
displayed on the iOS version of Tap Forms.

Phone

The Phone field will convert a set of digits
into a formatted phone number taking into
consideration different region formats for
phone numbers. The iPhone version will
also dial or text the number when the
phone button is tapped.

Photo

The Photo field will let you select a photo
from your disk or use the built-in camera to
take a photo. You can also drag and drop
an image into the Photo field. Once an
image has been attached to your Photo
field, you can click on the QuickLook button
to view a larger version of the photo or click
the trash button to delete it.

Rating

The Rating field will display up to 10 stars
that you can click on in order to rate your
records. For example, if you were
maintaining a movie library, you could add
the film’s popularity rating to your record.
Ratings can be used in calculations and
also at the form level. Therefore, you could
display the average rating for all the
movies in your library.

Script

The Script field is much like the Calculation
field, but you can write scripts using the
JavaScript language. You can use this to
perform much more complicated actions on
your data than the Calculation field. It can
also be more efficient and simpler to
understand when you have complex
formulas than with the Calculation field.

Section Heading

The Section Heading field will help you to
organize the fields within your form into
sections. This makes working with long
forms much easier.

Signature
The Signature field type on Mac is a read-
only field. You can create signatures on
iOS and view them on the Mac version.
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Table

The Table field type is a simple way of
creating a field that can hold multiple
values, displayed in a grid or tabular
format. Table fields are similar in some
ways to a form in that it’s comprised of one
or more fields itself. Bento had a similar
field type called a Simple List. You can also
select a form to connect to a Table field
which can be used to copy fields from into
your Table field. This also allows you to
select records from the connected form to
copy into your Table field’s sub-records.
Tap Forms will use the field titles in the
Table field to match the field titles in the
connected form in order to determine which
values to copy from the selected records.

Website

The Website field lets you store an address
to a website or even another application on
your own computer. When you click on the
website button to the right of the field, Tap
Forms will launch your web browser and
take you to the address specified.

Last modified: Jul 22, 2020

5.3. Field Properties
Tap Forms has a variety of properties available for each different field type. Some field types share common
properties while other fields have their own unique set of properties. Field properties are the settings that
allow you to customize how Tap Forms looks and behaves for each field type.

Here are a list of the properties and what they do for each field type

Property Name Field Types Description

Type All

This is where you specify what field type
you would like to use for the selected field.
If you change a field type, you will be
asked to confirm the switch. Not all field
types are compatible, so switching from
one field type to another may cause the
data in that field to be erased.

Title All The Title is used to identify each field in
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your form. They don’t have to be unique
names, but it’s better if they are, especially
when exporting and importing records.

Description All

You can enter a description for your field to
better help you remember what the field is
all about. The description will also appear
as a tooltip on the field title on the Default
Layout and on the field itself on your
custom layouts.

Title Color All
Allows you to set a colour for the label.
This affects only the Default Layout.

Value Color All
Allows you to set a colour for the field
value. This affects only the Default Layout
and the multi-column list view.

Hide Field All

Hides a field from being displayed on the
Default Layout. This can be useful if you
have a Script field that performs an
operation, such as setting values on other
fields, but does not need to display any
results itself.

Required Field Text, Number, Date, Note

Takes effect only when you have the Sho
w Edit/Save Button setting enabled in
the General Preferences panel. When you
click the Save button at the bottom of the
record details view, Tap Forms will
highlight in red all the fields that are
missing a value on the Default Layout.

Use Auto-Complete Text

A popup menu will be automatically
generated that contains a list of previously
entered values from all the records in the
form for the specific field.

Mask Field Value Text, Number, Web

This simply hides the content of the field
until you click a checkbox button next to
the field to reveal its contents. Masked
fields will show as •••• characters on the
records list view.

Show Title on List View Most, but not all
On the Single Column List View, the field
title will be displayed next to the value.

Display as Barcode Text, Number, Script, Web Tells Tap Forms to display the value of the
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field as a barcode on a custom layout. Has
no effect on the Default Layout.

Capitalization Text

Can be set to None, Words, or All
Characters. Affects whether or not Tap
Forms automatically capitalizes the
characters as you type without having to
hold down the shift key or caps-lock key.

Default Value Most, but not all

Allows you to set a default value to be
inserted at the time you create a new
record. Does not affect existing records.
For Date and Time type fields, the Default
Value is the current date and time.
For Checkmark fields, the Default Value is
either On or Off.

Pick List Text, Number
Associates the field with the selected Pick
List.

Checkbox/Radio
Columns

Text

When the associated Pick List’s Display
As property is set to Radio Buttons or C
heckbox Buttons, this property tells Tap
Forms how many columns to use to display
the Pick List values. This affects both the
Default Layout and custom layouts.

Label Position Text

This tells the Radio Buttons or Checkbox
Buttons Pick List to display the value label
either to the left, right, above, or below the
radio or checkbox button.

Auto-Increment Number

When a new record is created, Tap Forms
uses the Next Default Value property
to store it in the record for that field. It then
adds the Increment Amount value and
stores that in the Next Default Value
property ready to be used for the next
record.

Increment Amount Number
This contains the value that will be used to
increment the Next Default Value
after a new record is created.

Next Default Value Number
This stores the next value that will be used
when creating new records. It’s essentially
the same as the Default Value field, but is
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set when Auto-Increment is enabled.

Number Format Number, Currency, Script, Calculation

This controls how Tap Forms displays
numeric values. The choices are None,
Currency, Decimal, Percent, Scientific,
Spell Out, and 5 different Time styles. The
Time styles are useful for representing
duration values, such as 3:30 to represent
3 hours and 30 minutes. For Time styles,
Tap Forms converts the values stored as
seconds in the field into the specified
format. Tap Forms also converts the other
way around. For example, 0:10 (ten
minutes) will be converted to 600 seconds
when stored in the database.

Decimal Places Number, Calculation, Script

Sets how many digits to display after the
decimal point of the numeric value. Tap
Forms will round the value up the fewer
decimal places specified.

Highlight Negative
Numbers

Number, Calculation, Script Negative numbers will be displayed in red.

Summary Calculation Number, Calculation, Script

Can be set to one of Total, Average,
Minimum, Maximum, or Count. Displays
the result of the selected function at the
bottom of the records list view and at the
bottom of each group when the Show Gro
up Summaries option is enabled on the
records list view.

Date Format
Date, Time, Date & Time, Calculation,
Script

There are a number of different date
formats to choose from so you can
customize how dates are displayed in Tap
Forms. If you choose the Short, Medium,
Long, or Full options, Tap Forms uses the
format specified in System Preference
s > Language & Region > Advance
d > Date. You can customize the format
there.

Custom Date Format
Date, Time, Date & Time, Calculation,
Script

Use your own date format pattern to fully
customize how dates appear. See
Date_Format_Patterns for more
information on date patterns you can use.
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Link to Form Link to Form
This is the form you would like to link your
Link to Form field to.

Show Inverse
Relationship

Link to Form

Enabling this automatically creates a Lin
k From Form field within the Link to Form
which links back to this field. It allows you
to see the relationship in both directions.
For a One to Many Link Type, the
inverse relationship displays a single
parent record. For a Many to Many or a J
oin Link Type, the inverse relationship
displays a table of parent records.

Link Type Link to Form

There are 3 different relationship options
for the Link Type property. One to Many,
Many to Many, and Join. Please see
the chapter on Relationships for more
information on how these work.

Show File Name Photo
Enabling this will cause the Photo filename
to appear beneath the photo on the Default
Layout.

Thumbnail Size Photo

You can choose between small, medium,
and large photo thumbnail sizes to display
on the Single Column List View. This will
take effect when the Photo field is the very
first field in your form. So if you don’t see
the thumbnail, drag your Photo field up to
the first position in your form.

Photo Size Photo

This controls how large a photo Tap Forms
will store in the database when you attach
a photo. You can choose between Original,
Mini (512×512), Small (1024×1024),
Medium (1536×1536), or Large
(2048×248). Tap Forms will scale the
images proportionally to fit within the
specified size.

Resize All Photos Photo

If you would like to scale the photos within
your form for the specified field, click this
button. Tap Forms will use the Photo Size
option to scale the photos. Once you’ve
done this, go to the Database Maintenance
screen and click Compact Database to
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shrink the size of your database.
Depending on how many records you have
in your form, this operation may take quite
a while to complete.

Multi-File Enabled File Attachment

This tells Tap Forms to display a table of
files that you can attach to the field. If this
is turned off, you will only be able to attach
a single file to the field.

Maximum Value Rating
Set how many stars you want to display.
You can display up to 10 stars.

Last modified: Jan 24, 2020

5.4. Calculations
Tap Forms has a special field type called Calculation.

For basic math, use the following operators:

Operator Symbol

Add +

Subtract -

Multiply *

Divide /

Logical AND &

Logical OR ~

Modulo %

The following mathematical expressions in the Calculation field formula editor are supported:

In Tap Forms 5.2, for international regions which use a comma for the decimal point, you
will need to now use a comma in all the numbers you use in your formulas. You will also
need to use a semi-colon character as the delimiter between parameters in function calls.
Tap Forms will do this for you when you choose a function, but you will have to go back and
edit old formulas to use the semi-colon delimiter between function parameters.

*
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Date and Time

Function Description Notes Return Type

DATE(X; "yyyy-MM
M-dd")

Displays the
date in a
readable
format.

DATE(X; "yyyy-MMM-d
d hh:mm:ss a") displays
the date with the date and
time. The second
parameter is for
customizing the format.
Please see the Unicode
Technical Standard #35 for
pattern syntax and
examples.

Text

DATEADD(Dat
e;Y;M;W;D;H;M;S)

Adds the
date
components
to the
specified
date.

For example: DATEADD(Da
te;0;3;0;2;0;0;0) will
add 3 months and 2 days to
the specified date. Y =
Years, M = Months, W =
Weeks, D = Days, H =
Hours, M = Minutes, S =
Seconds.

Date

DATEVALUE(A; "yy
yy-MM-dd")

Returns a
date value
for the
specified
date text.

For example: DATEVALU
E("2017-12-31"; "yyy
y-MM-dd") returns the
date Dec 31, 2017.

Date

DAYS(X;Y)

Number of
days
between
dates

DAYS(X;Y) returns the
number of days between
the start and end dates.
e.g. DAYS(Start Date;
End Date).

Number

EOMONTH(Date;X)
Returns the
date for the
last day of

Returns the last day of the
month X number of months
before or after the specified

Date

If you don’t provide a value for every field in your formula, you will receive an empty result
for the Calculation field. To resolve this issue, you can either set a Default Value for all the
fields used in the formula, or you can use the IFEMPTY() function to return a default value
if none is provided. For example IFEMPTY(Price; 0; Price) which will return 0 if the
Price field is empty and the actual Price value if it’s not empty.

!

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en

Page 30 of 158

http://www.unicode.org/reports/tr35/tr35-31/tr35-dates.html#Date_Format_Patterns
http://www.unicode.org/reports/tr35/tr35-31/tr35-dates.html#Date_Format_Patterns


the month date.

HOURS(X;Y)

Number of
hours
between
dates

HOURS(X;Y) returns the
number of hours between
the start and end dates.
e.g. HOURS(Start Dat
e; End Date).

Number

MINUTES(X;Y)

Number of
minutes
between
dates

MINUTES(X;Y) returns the
number of minutes between
the start and end dates.
e.g. MINUTES(Start Dat
e; End Date).

Number

MMDD(X;Y)

Number of
months and
days
between
dates

MMDD(X;Y) returns the
number of months and
days between the start and
end dates as a text value.
e.g. 1 month, 3 days.

Text

MONTHS(X;Y)

Number of
months
between
dates

MONTHS(X;Y) returns the
number of months between
the start and end dates.
e.g. MONTHS(Start Dat
e; End Date).

Number

NEWDATE(Y;M;W;W
D;WO;D;H;M;S)

Creates a
date given
the specified
components.

For example: NEWDATE(20
17;11;0;0;0;2
2;0;0;0) will create a
date for 2017-11-22. Y =
Year, M = Month, W =
Week of Year, WD =
Weekday, WO = Week
Ordinal, D = Days, H =
Hours, M = Minutes, S =
Seconds.

Date

NOW()
Inserts the
current date
& time.

Inserts the current date &
time in Unix Epoch date
format, which is the number
of seconds elapsed since
January 1, 1970 00.00.00
GMT.

Date

TODAY() Inserts the
current date.

Inserts the current date in
Unix Epoch date format,

Date
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which is the number of
seconds elapsed since
January 1, 1970 00.00.00
GMT.

WEEKDAYS(X;Y)

Number of
weekdays
between
dates

WEEKDAYS(X;Y) returns
the number of weekdays
between the start and end
dates. e.g. WEEKDAYS(Sta
rt Date; End Date).

Number

WEEKNUM(X)
The week
number of
the year.

Returns the week number
of the year from 1 to 52.

Number

YEARS(X;Y)

Number of
years
between
dates

YEARS(X;Y) returns the
number of years between
the start and end dates.
e.g. YEARS(Start Dat
e; End Date).

Number

YYMM(X;Y)

Number of
years and
months
between
dates

YYMM(X;Y) returns the
number of years and
months between the start
and end dates as a text
value. e.g. 1 year, 2 months

Text

YYMMDD(X;Y)

Number of
years,
months and
days
between
dates

YYMMDD(X;Y) returns the
number of years, months
and days between the start
and end dates as a text
value. e.g. 2 years, 1
month, 3 days.

Text

Conditionals

Function Description Notes Return Type

IF(X;Y;Z) Provides
branching.

IF(X;Y;Z) provides branching
capability. If X is not 0, then it
returns Y, else it returns Z.

Text/Number/Date

IFEMPT
Y(X;Y;Z)

Checks if X is
empty.

IFEMPTY(X;Y;Z) checks for
empty value of X. If X is empty,
then it returns Y, else it returns Z.

Text/Number/Date

IFEQUA If A and B are IFEQUAL(A;B;C;D) will return C Text/Number/Date
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L(A;B;C;D)
equal, return
C, otherwise
return D.

if A and B are equal. If A and B
are not equal, returns D. A and B
must be text.

IFNOTEMPT
Y(X;Y;Z)

Checks if X is
not empty.

IFNOTEMPTY(X;Y;Z) checks to
see if X is not empty. If X is not
empty, then it returns Y, else it
returns Z.

Text/Number/Date

Text

Function Description Notes Return Type

CONCA
T(X;Y;...)

Joins
strings
together.

CONCAT("abc";"def";...) function
returns the combined string “abcdef”. There is
no limit on the number of parameters.

Text

FORMAT(X;
"#.00")

Customize
the display
of numeric
values.

FORMAT(X; "#.00") displays the value of X
using the provided number format. Please see
the Unicode Technical Standard #35 for
pattern syntax and examples.

Text

LEFT(A; X)

Returns the
left most X
characters
from the
text A.

For example, LEFT("Tap Forms"; 3)
returns the value “Tap”.

Text

LENGTH(A) Returns the
length of A.

Returns the number of characters in the text
value A.

Text

POS(A; B)

Returns the
position of
B within the
text A.

For example, POS("Tap Forms"; "Form
s") returns the numeric value 5.

Number

RIGHT(A;
X)

Returns the
right most X
characters
from the
text A.

For example, RIGHT("Tap Forms"; 5)
returns the value “Forms”.

Text

STR2NUM(A)

Return the
numeric
value of the
specified
text value

STR2NUM("25") returns the number 25. STR
2NUM("11.5") return the number 11.5.

Number
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A.

SUBSTR(A;
X; Y)

Returns
characters
from A for
the given
range.

Returns a string containing the characters
from A for the specified range. X is the starting
position. Y is the length of characters to return.

Text

UUID()
Returns a
unique
identifier.

Generates a Universally Unique Identifer
(UUID). For example
A432C2F2-A662-545B-16AD-0A357A3E6E5F.

Text

Math and Trigonometry

Function Description Notes Return Type

ABS(X) Absolute
value of X.

ABS(X) returns the absolute value.
e.g. ABS(4) = 4 and ABS(-4) = 4.

Number

ATAN(X) Arctangent
of X.

ATAN(X) returns the arctangent
value of X.

Number

AV
G(X;Y;...)

Returns the
average of
the
parameters.

AVG(X;Y) returns the average of
X and Y. e.g. AVG(5; 3) is 3.5.

Number

CEIL(X)
Rounds the
value of X
up.

CEIL(X) rounds up the value of X
to the nearest integer. e.g. CEI
L(-3.2) = -3, CEIL(3.2) = 4.

Number

COS(X) Cosine of X
COS(X) returns the cosine of the
angle X in radians.

Number

COSH(X)
Cosinus
Hyperbolic
function.

COSH(X) returns the cosinus
hyperbolic value of X.

Number

COTAN(X) Cotangent
function.

COTAN(X) returns the cotangent of
X.

Number

EXP(X) Exponent
function.

EXP(X) computes e**x, the base-e
exponential of x.

Number

FLOOR(X)
Rounds the
value of X
down.

FLOOR(X) rounds down the value
of X to the nearest integer. e.g. FL
OOR(-3.2) = -4, FLOOR(3.2) =
3.

Number
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INTPO
W(X;Y)

Raises X to
the power of
Y returning
an integer.

INTPOW(X;Y) raises X to the
power of Y returning an integer.
e.g. INTPOW(2; 3) = 8 and INTP
OW(2; 3.4) = 8 also.

Number

LN(X) Natural log
function.

LN(X) natural log function. Number

LOG(X) 10 based log
function.

LOG(X) 10 based log function. Number

LOGN(X;Y) Log base X
of Y function.

LOGN(X;Y) returns the log base X
of Y. e.g. LOGN(10; 100) = 2.

Number

MA
X(X;Y;...)

Returns the
maximum of
the
parameters.

MAX(X;Y) returns the maximum of
X and Y. e.g. MAX(2; 3) is 3.

Number

MI
N(X;Y;...)

Returns the
minimum of
the
parameters.

MIN(X;Y) returns the minimum of
X and Y. e.g. MIN(2; 3) is 2.

Number

POW(X;Y)
Raises X to
the power of
Y.

POW(X;Y) raises X to the power of
Y. Supports decimal values.

Number

RND()

Generates a
random
number
between 0
and 1.

To generate a random number
between 0 and 100, just multiply
the result by 100.

Number

SIGN(X)

Returns -1 if
X<0; +1 if
X>0, and 0 if
X=0.

SIGN(X) returns -1 if X<0; +1 if
X>0, and 0 if X=0.

Number

SIN(X) Sin of X
SIN(X) returns the sine of the
angle X in radians.

Number

SINH(X)
Sinus
Hyperbolic
function.

SINH(X) returns the sinus
hyperbolic value of X.

Number

SQR(X) Square of X
SQR(X) returns the square of the
value of X.

Number
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SQRT(X) Square root
of X.

SQRT(X) returns the square root of
X.

Number

SU
M(X;Y;...)

Returns the
sum of the
parameters.

SUM(2;3;5;...) Returns the
sum of it’s arguments. There is no
limit on the number of parameters.

Number

TAN(X) Tangent
function.

TAN(X) tangent function. Number

TRUNC(X)
Truncates
the fractional
part of X.

TRUNC(X) discards the fractional
part of a number. e.g. TRUN
C(-3.2) is -3, TRUNC(3.2) is 3.

Number

Text Concatenation

In addition to the above mathematical expressions, Tap Forms also supports text concatenation. With this
feature, you can create Calculation fields which return a Text value instead of a Number value.

For example, you could create a Calculation field called Full Name (or whatever you want to call it) which
has the following formula:

First Name + “ “ + Last Name

As long as you set the Result Type property on the Formula Editor to Text, then Tap Forms will evaluate
the above formula and return the string with the First Name and Last Name fields joined together with a
space character in between. It’s especially useful for creating labels. You can keep your First Name and
Last Name fields as separate fields, but for printing labels, you would want them to be joined together into a
Full Name field to make your labels look nicer.

Eliminating blank lines from a mailing address label if certain values are empty

First Name + " " + Last Name + "\r" +
IFNOTEMPTY(Company; Company + "\r"; "" ) +
Address 1 + "\r" +
IFNOTEMPTY(Address 2; Address 2 + "\r"; "" ) +
City + ", " + Province + "  " + Postal Code

In the above example, the IFNOTEMPTY ( Company; Company + “\r”; “” ) part checks to see if the Company
field is not empty. If it has a value, it returns the value in the Company field and adds a linefeed character to
it. If it has no value, it simply returns nothing (an empty string).

The "\r" part inserts a new line into the result.
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Quoting Special Characters
There are some special characters in Tap Forms which require you to prefix them with a \ character. The
following is a list of characters that require escaping in order to be used within quotes:

", ,, and ;

For example,

CONCAT("Last Name\, First Name")

The comma between Last Name and First Name must be escaped with the \ character.

Last modified: Oct 13, 2019
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6. Records
Records, which sit between fields and forms, represent the items in your collection. The topics in this
category cover how records can be used and the sorting functionality for records.

Records

• How to Use Records
• Sorting Records

Last modified: Sep 14, 2018

6.1. How to Use Records

Records, comprised of fields, are the pieces of data that make up an overall form. A record is most often
an item in an overall collection – like a book or movie – but can also function as dates, tasks, and more.
Basically, you’ll use records to input information that will contribute to a bigger list.

To start working with records, you’ll first need a form (you can read more about forms here). Once you’ve
decided on an overall topic, you can begin adding records via the + icon, which is present in all views.
Records’ characteristics are set by fields, which are unique inputs meant for adding context to your data
entries – without adding fields, you’ll only have the title of the record to edit.

With the big-picture form idea and the right fields set, you’re on your way to creating records. As you add
records, they’ll appear in the view you’ve selected, acting as individual reference points as you view your
information. When viewing a record, your data will be added to the default layout, which displays your
information vertically.

As mentioned previously, records function best when used as individual portions of a greater subject. For
example, you might use a record to represent a movie in your overall collection or act as an event for an
important date. Although records can function as multiple pieces of data, using records for one
representation can simplify your database.
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Last modified: Feb 20, 2019

6.2. Sorting Records
After inputting records into your form, the next step is choosing an organizational strategy for when they are
displayed across their various views. This is done with sorting, and the proper utilization of it can
drastically improve how useful records can be.

In the Forms inspector panel on the right side of the screen, under the Form tab, sort settings live in the
“Sort & Group Settings” header in dropdown menus. Sorting can be done in three intervals that take
priority over the next – for example, you can sort by name and then date, with name having a preference.
Sorting with records is done through fields, meaning that you’ll choose the fields that you want to use to
organize your records.

When you choose your sorting method, Tap Forms will immediately sort your data by the criteria you’ve
listed. Based on what you’ve entered into fields, the app can read the various options and choose the best
way to categorize your records. In many instances, you’ll sort by the first letter of the title, a date, or an
important number. However, you can also sort by any field you’ve added to a record.

Sort can be done in ascending or descending order, and Tap Forms is smart enough to understand the
unique sorting rules for a particular field. As an example, the “Text” field can be sorted alphabetically, but a
“Date” field understands the order of months and will sort accordingly.

Last modified: Mar 26, 2020

6.3. Searching

To quickly access record information, Tap Forms includes search functionality that can be used via the
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toolbar. Search offers two basic features: a general search and saved searches.

General Search

With a general search, you’ll get exactly what you’d expect; type your text into the search field and Tap
Forms will search the database for records related to that term or phrase. You’ll first see search results for
the currently selected form – however, if you’d like to search all forms in the document, click the “All Forms”
button, which can be found just below the toolbar when the general search is being used. If your term or
phrase is found within multiple forms, Tap Forms will present them within the view with their respective form
titles. Below the toolbar is also a “Save” button, which is used to quickly store a search below its form. This
feature then allows you to click on the saved search instead of typing your search each time you’d like to
find the data.

Saved Searches

Saved Searches are a more advanced form of searching, offering you unique filtering options to filter your
records. To get started, click the filter icon just to the left of the search bar. Saved Searches allow you
to filter based on specific fields whereas the General Search searches all fields at once.

To perform an exact match search, put your search term in straight double-quotes. E.g. "AB
C-123" will find all records that have the value ABC-123 in them. If you leave out the
double-quotes, punctuation will be ignored. In fact, with the - in the search term, Tap Forms
will include all records with ABC, but exclude the ones that also contain 123. The - acts as
a negate function.

*
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In this window, you can create a customized search that operates on certain rules based on your fields; for
example, if you’d like to quickly find high-quality action-adventure movies in your library, you can set rules to
only show 3-star and above movies that you’ve labeled with the genre of “Action-Adventure”. Saved
searches appear under their forms, and once you’ve clicked the title, it’ll automatically filter the relevant
records.

To delete a saved search, select the search and right-click it before clicking “Delete Search”. You can
also select it and then select “Delete Search” from the Forms menu.

Search Rules

Search rules can be completely customized to your liking, and to further refine your searches, you can
combine multiple rules together. The process is as follows:

1. Select the field you want to sort first. This is completed through the first dropdown menu.
2. Choose the sorting function. Example: is, is not, contains, is, greater than or equal to
3. Enter your criteria. This can be a word, phrase, or number.

Search Folders

Tap Forms 5.3 also now has the ability to organize your Saved Searches into folders and sub-folders.

To create a search folder:

1. Right-click on your form and select the Create Search Folder… option.
2. Type in a name for your search folder.
3. Click the Save button to save your folder.

When you add multiple Search Rules, Tap Forms will combine each rule together to reduce
the number of records returned from the search. Therefore, the more Search Rules you
add, the fewer records will be returned. Click the All popup button and change it to Any if
you’d like to expand the search results list by adding more search rules.

*

You can also use an OR search between terms within the same value when using the cont
ains operator – for example, Move Tile contains Terminator OR Hunger. You
would put just Terminator OR Hunger into the search term field to accomplish this. The
OR must be in uppercase.

*
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4. Drag your Saved Searches into the search folder.

Last modified: Sep 18, 2019
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7. Views
In the Views set of topics, this guide will discuss the various ways to see the records and forms you’ve
created. Each topic features images and descriptions of the corresponding views, including their ideal use
cases.

Views

• Single-Column List
• Multi-Column
• Calendar
• Map
• Photo Grid

Last modified: Jun 07, 2018

7.1. Single-Column List

As the default option, the Single-Column List view organizes your records by displaying them one-by-one
in a list. The Single-Column List is perfect for records that you want to sort by one specific criteria, like
name, date, or size.

When building a form with records, the fields you use to characterize a record can be turned into the
sorting method for the Single-Column List. For example, if you’re creating a shopping list, you might want to
sort the form by “Name”.
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After you’ve begun to populate your form with records and fields, you can decide how you want to sort your
lists. To do this, navigate to the “Sort and Group Settings” section of the Form tab. Here, you’ll choose up
to three sort fields, as well as decide to organize in ascending or descending order.

Adding records to your forms will populate the Single-Column List view, organizing themselves by the
criteria you’ve outlined.

Last modified: Jun 07, 2018

7.2. Multi-Column
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With the Multi-Column view, records assume a more table-like display, organizing your data across
multiple columns. When you click on a particular record in Multi-Column, your fields’ titles will populate the
titles of each column, with their data entries filling the rows beneath.

Benefits

Fields in this view can be compared almost instantly, and the Multi-Column view is perhaps best used for
getting an overall idea of your particular record. Multi-Column works best for records that are text-
heavy, and can often be used with large sets of data.

Another benefit of using the Multi-Column view is the ability to instantly jump to a particular field and edit its
data – in most other views, you’d be required to click on a record and edit the information there. However,
though there is still the default record layout along the bottom, the spreadsheet offers quick editing
functionality.

Editing the Multi-Column View

Like spreadsheets, the size of the cells in the Multi-Column view can be increased or decreased by
clicking and dragging on their edges and dragging back and forth. Along the top of the view is a slider
to change the font size, as well as an option to remove sections in the spreadsheet.

To remove or rearrange fields from the table view:

1. Open the Multi-Column view
2. Click the icon resembling an “x” at the end of the header row
3. Tick the boxes to hide any fields from the table
4. Drag the fields above and below other fields to rearrange their positions
5. Click the Save button when done
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To display sections with sub-totals:

1. Click the button that resembles a little menu at the top-right of the Multi-Column view
2. Select the Show Section Headings option
3. Select the Show Group Summaries option

To display calculation totals

You can tell Tap Forms to display totals, averages, minimums, maximums, or the count of the records in the
form for each field.

1. Click the Sigma [ ∑ ] button in the bar that displays between the multi-column list view and the record
details view to display the footer row.

2. Click the popup buttons in the footer to select the type of aggregate calculation you would like to see.

Section Headings must be enabled for Group Summaries to appear.*
If you don’t see the record details view at the bottom of the multi-column list view, you may!
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Last modified: Sep 14, 2022

7.3. Calendar

The Calendar view found in Tap Forms is an alternate option to the default Single-Column List view. With
Calendar, records created are organized and displayed on a traditional monthly calendar, allowing you to
see them in a schedule format.

To utilize the Calendar view, you must create a “Date” or “Date & Time” field
when setting up your records. To do this:

1. Open the Form sidebar
2. Click the “Fields” tab
3. Click the + icon to add a field
4. Select either “Date” or “Date & Time” from the dropdown menu

have hidden that view. Either click the Show or hide detail view button at the bottom right
of the records list or drag the bottom bar where the records count is displayed upwards until
the record details display.
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In Calendar, you’ll see a large monthly calendar displayed at the top of the window with a list of events
along the right side. Records with dates will appear on their relevant day, and the title of a record will also
display on the calendar. At the top left of a day with an event, you’ll see a number within parentheses
indicating how many events are on that particular day. If you’d like to see more of the calendar, you can
expand it by dragging on its left, right, and bottom sides.

To the right of the calendar is a column list of records, sorted by the “First Sort Field” option in the Form
sidebar. To view the records arranged by a specific date field, select a field from the “Arrange by” pull-down
menu. Along the bottom of the window are layouts, which display more information about the records you’ve
created. This is also where you’ll add information about new records, including their title, date, and more.

You can also filter records by a specific date. To do this, follow these steps:

1. Click on the specific date.
2. To view the full list of records in the form, click the date again to deselect that day.
3. To view records for multiple dates, press the shift key while clicking on the desired date range.
4. To show or hide the records list, click on the arrow button in the upper right corner of the calendar.

You can navigate between months by clicking the arrow icons at the top of the calendar.*

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en

Page 48 of 158



Last modified: Jun 07, 2018

7.4. Map

Similar to the Calendar view, Tap Form’s Map view uses a specific field type – Location – to offer a unique
look at your form. Any record with the Location field will be placed on a map using a small circle indicator.

To get started with Map:

1. Click the Location field button on each record to display a map for that specific field.
2. Click the Locate Me button to pinpoint your current location or use the search function to search for a

location.
3. Click Save to save that location.

When your records are outfitted with locations, click the Arrange by menu above the map to display the
records. Each record will be represented by a small red circle at its particular location, the circle remaining
the same size as you move in and out to see the specifics of each location. When many records have
locations within the same area, Tap Forms will cluster the points together and display the count of the
number of records with locations within that specific area.

Below the map is the record layout, including any custom layouts you’ve created for the particular form. To
the right is a simple list view of your records, which can be sorted via the Form sidebar.

Last modified: Feb 20, 2019

To change the default pin color, visit Preferences. Tap Forms will also generate different pin
colors if you’ve defined a Pick List that has colored values and assigned them to a field in
the form. You also need to set the Record Color Field option on the Form properties to
enable this feature.

*
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7.5. Photo Grid

Forms containing photos can utilize the Photo Grid view to organize and display their respective records.
With Photo Grid, images become the main reference point for your records, great for forms with book
covers, movie posters, photos from a trip, and more.

For photos to appear in Photo Grid, you must have a “Photo” field set for the
records in the form. To do this:

1. Open the Form sidebar
2. Click the “Fields” tab
3. Click the + icon to add a field
4. Select “Photo” from the dropdown menu

Once you’ve added the field, add a photo through drag and drop, the + icon, or take a photo via the camera
icon. Photo Grid will show these images in a list format alongside the form’s layouts, creating thumbnails for
each record.
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At the top of the Photo Grid is a slider, which functions to increase or decrease the size of your photos.
Alongside the slider is the “Arrange by” dropdown menu – you’ll need to have this set to your photo field in
order to see the images. If you feel your images are too small, you can drag the edges of Photo Grid out to
increase their size.

In the Form sidebar under Fields, select the Photos field within your form and scroll to the bottom to adjust
the image size and quality. This can be done on an individual or multi-photo basis.

Hiding sections gives a cleaner view of the grid.*
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8. Scripts

New to Tap Forms 5.3 are Scripts both at the Form level and Field level. Scripts allow you to write code
that can perform complex actions on your data.

Field Level Scripts

The Script field is similar to the Calculation Field in that it gets executed when any field the script
references changes. The mechanism that triggers the script to be executed is when you have a reference to
a field in your script via the record.getFieldValue(field_id) function and that field changes in the
record. Scripts can often be more efficient and easier to understand when dealing with complex formulas.
So if your formula starts to get complex, you might consider using a Script field instead.

To create a Script field:

Scripts must be written in the JavaScript programming language. Please see this link for
more information about what JavaScript syntax is supported: https://tc39.github.io/ecma262/*
For a getting started tutorial on scripting, please see Tap Forms Scripting 101 This is useful
even if you have no prior programming experience.*
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1. Open the Forms sidebar and click “Fields”
2. Click the + button to add a new field
3. In the dropdown menu, choose the Script field type
4. Scroll down to find the Edit Script… button and click on it. You can also double-click on a Script field

to quickly open the Script Edit window

After you’ve clicked the Edit Script… button, you’ll be able to input your own custom scripts, as well as use
snippets and available fields to help you in the process. As you work, you can choose how you’d like the
result to be returned to the field (number, date, text, etc.). You can also adjust the text size of the script
you’re written with the font size slider. When you’ve finished, clicking Save will save the script to your field.

Form Level Scripts

In addition to field scripts, Tap Forms 5.3 also supports form level scripts, which can be used to create

If you don’t want to have your script update all the records in your form, uncheck the
Update records when saving checkbox button. Saving will now simply save the script and
will not loop through your records executing the script for each record.
*
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new records and update existing records within your forms. Form scripts are executed manually by you.

To create and modify these scripts, visit the Scripts tab in the form inspector panel. You can double-click a
Script to go directly to the Script Edit window. Scripts can also have keyboard shortcuts added to them to
make running them easier when using the keyboard. All form scripts will appear in the new Scripts menu in
the menubar at the top of the screen. Selecting a script from the Scripts menu will run the selected script.

Built-in Tap Forms specific objects

A Tap Forms database consists of Forms, Searches, Fields, Pick Lists, Categories, Records and values. A
few of these things can be accessed right from within a script using the following built-in objects:

• form
• search
• record

See the Tap Forms JavaScript API to find out what specific functions are available to you.

Snippets

Within the Tap Forms Script Editor, there is a list of Snippets that you can use to help you get access to the
records and values that you will need when writing your scripts. For example, to get access to the list of
records in a form, use the following line of code:
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var records = form.getRecords();

Once you’ve defined the records variable, you can then write code to loop through the array of record
objects, picking out values from specific fields in your form. Tap Forms makes this easy by automatically
writing code for you when you double-click on a field name and double-click on a Snippet.

For example, here’s a block of code for a form level script which loops through all the records in a form and
totals up the revenue from all of the movies in a Movies form:

var records = form.getRecords();
var revenue_total = 0;

for (var index = 0, count = records.length; index < count; index++){
var theRec = records[index];
var movie_revenue = theRec.getFieldValue('fld-987c9aac738a4f0fa1d18395902b3fc

1');
if (movie_revenue) {

revenue_total += movie_revenue;
console.log('Revenue: ' + movie_revenue);

}
}

revenue_total;

You may also notice there’s a line of code that says console.log('Revenue: ' + movie_revenue);.
That tells Tap Forms to output that line to the console log area on the Script Editor screen. This is very
useful for debugging your scripts as Tap Forms doesn’t have a formal JavaScript debugger built-in. You will
need to use the console.log() function to aid in debugging.

Fetch Movie Data from Web Service

Here’s an example Field script which fetches movie data when entering a value into a barcode field. You
can even use it to scan a barcode using the iOS version. It will automatically fetch the data and fill in the
fields for you, including downloading a movie case cover photo.

var movie_title_id = 'fld-987c9aac738a4f0fa1d18395902b3fb1';
var genre_id = 'fld-2a0d16d2aece4562b6f44170cf1736a6';
var case_cover_id = 'fld-e2cf02f376864a7cb9f090e4a597f3e4';
var summary_id = 'fld-28cc8f7f082c43818f1169c96c96e5a9';
var imdb_website_id = 'fld-9bc90613e8db45fea77579f35eb53b9d';
var barcode_field_id = 'fld-7e3ead95de51427fa5a467b2476d58cd';

function fetchProductInfo() {
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var barcode = record.getFieldValue(barcode_field_id);
var url = 'https://api.upcitemdb.com/prod/trial/lookup?upc=' + barcode;
var product_info = Utils.getJsonFromUrl(url);
return product_info;

}

var product = fetchProductInfo();
var code = product['code'];

if (code == 'OK') {
var items = product['items'];
var item = items[0];
var images = item['images'];
var imageUrl = images[0];
var offers = item['offers'];
var offer = offers[0];
var link = offer['link'];
record.setFieldValue(imdb_website_id, link);
record.setFieldValue(movie_title_id, item['title']);
record.setFieldValue(summary_id, item['description']);

if (imageUrl != undefined) {
record.addPhotoFromUrlToField(imageUrl, case_cover_id);

}
form.saveAllChanges();

}

And here’s another Field script which returns a simple value by multiplying 2 values together and returning
the result:

var amount_id = 'fld.....';
var quantity_id = 'fld....';
var amount = record.getFieldValue(amount_id);
var quantity = record.getFieldValue(quantity_id);
var total = amount * quantity;
'The total is: ' + total;

In the above script, because it returns a Text value, make sure you set the Result Type to Text.

Please note that the field IDs in the above script (e.g. movie_title_id = ‘fld-….’) are unique to
the form this script was written for. You would need to use your own field IDs from your own
form to make this script work.
*
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Last modified: Dec 16, 2020

8.1. JavaScript API
The Tap Forms JavaScript Application Programming Interface (API) provides you with specific extensions to
the JavaScript virtual machine that lets you create, update, and delete various objects within your Tap
Forms database document.

Here are a list of objects and the functions you can call on each.

document
Function/Property Parameters Returns Description Example

createNewFormNamed() text form

Call this to
create a new
form with the
specified
name.

document.createNewFormNamed('My
New Form');

getFormIdsByName() text array

Returns the list
of form IDs for
the specified
form name.

document.getFormIdsByName('Movie
s');

getFormNamed() text form

Call this to
fetch a form
with the
specified
name.

document.getFormNamed('My Movie
Library');

getForms() none
array of
forms

Call this to
fetch an array
of all the forms
in your
database
document.

document.getForms();

getFormWithId() form ID form

Call this to get
a form with the
specified form
ID.

document.getFormWithId('frm-1234
567890abcdef');

getId() none text
Returns the ID
of the current
document

document.getId();
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Function/Property Parameters Returns Description Example

getPickListNamed() text Pick List

Call this to
fetch a Pick
List with the
specified
name.

document.getPickListNamed('Prior
ities');

getPickLists() none
array of
Pick List

Call this to
fetch the list of
Pick Lists in
the database.

document.getPickLists();

name none text
Returns the
name of the
document.

document.name;

saveAllChanges() none Bool

Call this to
save any
changes your
script has
made to the
database
document.

document.saveAllChanges();

selectFormLayout()
form ID,
layout ID

none

Selects a form
and a specific
layout. Pass
null for the
layout ID to
select the
Default Layout

document.selectFormLayout(form_i
d, layout_id);

form
Function/Property Parameters Returns Description Example

addField() Field none
Adds the
specified Field
to the form.

form.addField(field);

addNewFieldNamedWithType()

name, type
(text,
number,
calc,
location,

Field

Adds a new
field to the
form with the
specified
name and

var field = form.addNewFiel
dNamedWithType('Quantity',
'number');
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Function/Property Parameters Returns Description Example

photo) field type.

addNewRecord() none record
Adds a new
record to the
form.

var newRecord = form.addNew
Record();

addNewScriptNamed() text Script
Adds a new
Script to the
form.

var newScript = form.addNew
ScriptNamed("My Script");

deleteRecord() record
error
string

Deletes the
specified
record from
the form.

form.deleteRecord(someRecor
d);

deleteScriptNamed() text
error
string

Deletes the
first Script with
the specified
name from the
form.

form.deleteScriptNamed("My
Script");

deleteScriptWithId() text
error
string

Deletes the
Script with the
specified ID
from the form.

form.deleteScriptWithId("sc
r-blahblah");

getAvgOfField() field ID number

Returns the
average value
of all the
records in the
form for the
specified field.

form.getAvgOfField(fieldI
D);

getFieldIds() none array

Returns an
array of all the
field IDs in the
form.

form.getFieldIds();

getFields() none array

Returns an
array of all the
TFField
objects in the
form.

form.getFields();

getFieldsForType()
type (text,
number,
check_mark,

array
Returns an
array of all the
TFField

form.getFieldsForType('tex
t');
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Function/Property Parameters Returns Description Example

date, time,
date_time,
calc, note,
etc.)

objects in the
form for the
specified type.

getFieldNamed() text Field

Returns the
TFField object
for the
specified field
name.

form.getFieldNamed('Movie T
itle');

getFieldWithId() field ID Field

Returns the
TFField object
for the
specified field
ID.

form.getFieldWithId('fld-ab
cde1234');

getId() none form ID

Returns the
internal
unique ID of
the form.

form.getId();

getLayoutNamed() text Layout

Returns the
TFFormLayout
object for the
specified
layout name.

form.getLayoutNamed('Print
Layout');

getLayoutWithId() layout ID Layout

Returns the
TFFormLayout
object for the
specified
layout ID.

form.getLayoutWithId(layou
t_id);

getLayouts() none
array of
layouts

Returns all the
layouts for the
form.

form.getLayouts();

getMaxOfField() field ID number

Returns the
maximum
value of all the
records in the
form for the
specified field.

form.getMaxOfField(fieldI
D);

getMinOfField() field ID number Returns the form.getMinOfField(fieldI
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Function/Property Parameters Returns Description Example

minimum
value of all the
records in the
form for the
specified field.

D);

getRecords() none array

Returns an
array of record
objects for the
specified form.

var records = form.getRecor
ds();

getRecordWithId() record ID record

Returns the
record for the
specified
record ID.

form.getRecordWithId('rec-1
23456789abcdef');

getRecordsForSearchTerm() text array

Returns an
array of record
objects for the
specified
search term.

var records = form.getRecor
dsForSearchTerm("search ter
m");

getScriptNamed() text Script

Returns the
first Form
Script with the
specified
name.

form.getScriptNamed("My Scr
ipt");

getScripts() none
array of
Script

Returns the
array of Script
objects in the
form.

form.getScripts();

getSearchNamed() text Search

Returns a
search object
given the
name of a
search.

form.getSearchNamed('Genr
e: Action &amp; Adventur
e');

getTotalOfField() field ID number

Returns the
total sum of all
the records in
the form for
the specified
field.

form.getTotalOfField(fieldI
D);
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Function/Property Parameters Returns Description Example

name none text
Returns the
name of the
form.

form.name;

runScriptNamed() text none

Runs the
Form Script
with the
specified
name. Used
for including
scripts inside
other scripts.

form.runScriptNamed('Commo
n Functions');

saveAllChanges() none Bool

Call this to
save any
changes your
script has
made to the
database
document.

form.saveAllChanges();

selectRecord() record none

Selects the
specified
record on the
form.

form.selectRecord(someRecor
d);

field
Function/
Property

Parameters Returns Description Example

defaultValue none text
Get or sets the field’s
default value.

field.defaultValue = 'some valu
e';

fieldDescription none text
Returns the description
of the field.

field.fieldDescription;

fieldType none text
Returns the type of the
field.

field.fieldType;

form none Form
Returns the form the
field belongs to.

field.form;

getId() none field ID
Returns the internal
unique ID of the field.

field.getId();
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Function/
Property

Parameters Returns Description Example

hideField none none
Sets the field to be
hidden or not.

field.hideField = true;

isCollapsed none none
Sets the Section field to
be collapsed or not.

field.isCollapsed = true;

name none text
Returns the name of the
field.

field.name;

script none text
Returns the JavaScript
code for the specified
field.

field.script;

sortOrder none number
Get or set the field sort
order.

field.sortOrder = 2;

layout
Function/
Property

Parameters Returns Description Example

getId() none
layout
ID

Returns the internal unique
ID of the layout.

layout.getId();

name none text
Returns the name of the
layout.

layout.name;

pick lists
Function/
Property

Parameters Returns Description Example

getId() none
pick list
ID

Returns the internal unique
ID of the pick list.

pick_list.getId();

name none text
Returns the name of the
Pick List.

pick_list.name;

values none
Array of
Dictionary

Returns an array of
dictionaries for the Pick List.
The dictionary keys are val
ue and valueColour

pick_list.values;
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record
Function/Property Parameters Returns Description Example

addNewRecordToField() field_id record

Used for
adding a
new record
to a Link to
Form or
Table field.

var newRecord = record.addNe
wRecordToField(field_id);

addFileFromUrlToField() url, field_id none

Fetches a
file from the
specified
URL and
adds it to
the File
Attachment
field
specified by
field_id. The
file can be a
local file
URL on disk
in the Mac
version
when you
have the
Script
Folder
specified on
the General
Preferences
window.

record.addFileFromUrlToFiel
d(file_url, file_field_id)

addPhotoFromUrlToField() url, field_id none

Fetches a
photo from
the
specified
URL and
adds it to
the Photo
field
specified by
field_id

record.addPhotoFromUrlToFiel
d(image_url, case_cover_id)
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Function/Property Parameters Returns Description Example

addRecordToField()
record,
field_id

none

Used for
adding an
existing
record to a
Link to
Form or
Table field.

record.addRecordToField(some
Record, field_id);

dateCreated none date

Returns the
date the
record was
created.

var created = record.dateCre
ated;

dateModified none date

Returns the
date the
record was
modified.

var modified = record.dateMo
dified;

deviceName none text

Returns the
name of the
device that
modified the
record last.

var device = record.deviceNa
me;

duplicate() none record
Returns a
new copy of
the record.

var copyOfRecord = record.du
plicate();

form none Form

Returns the
form this
record
belongs to.

record.form;

getAvgOfLinkedFieldForField()
linked field
ID, field ID

number

Returns the
average of
all the
records in
the linked
field for the
specified
field.

record.getAvgOfLinkedFieldFo
rField(linkedFieldID, fieldI
D);

getFieldValue() field_id object

Gets the
value for
the
specified

var barcode = record.getFiel
dValue(barcode_id);
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Function/Property Parameters Returns Description Example

field from
the record.
The return
type
depends on
the field
you’re
getting the
value from.

getId() none record ID

Returns the
internal
unique ID of
the record.

record.getId();

getMaxOfLinkedFieldForField()
linked field
ID, field ID

number

Returns the
maximum
value of all
the records
in the linked
field for the
specified
field.

record.getMaxOfLinkedFieldFo
rField(linkedFieldID, fieldI
D);

getMinOfLinkedFieldForField()
linked field
ID, field ID

number

Returns the
minimum
value of all
the records
in the linked
field for the
specified
field.

record.getMinOfLinkedFieldFo
rField(linkedFieldID, fieldI
D);

getNoteFieldValue() field_id
note
value

Gets the
rich text
note field
value from
the
specified
Note field.

record.getNoteFieldValue(fie
ld_id');

getRecordColor() none
web hex
color

Gets the
web hex
colour value
for the

var color = record.getRecord
Color();
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Function/Property Parameters Returns Description Example

record.

getTotalOfLinkedFieldForField()
linked field
ID, field ID

number

Returns the
total sum of
all the
records in
the linked
field for the
specified
field.

record.getTotalOfLinkedField
ForField(linkedFieldID, fiel
dID);

getUrl() none url

Gets the
URL for the
record. This
is the same
URL as the
Copy
Record Link
function
under the
Edit menu.

record.getUrl();

removeRecordFromField()
record,
field_id

none

Removes a
record from
a Link to
Form or
Table field.

record.removeRecordFromFiel
d(childRecord, field_id');

recordExistsInField()
record,
field_id

boolean

Returns
true if the
record
exists in the
Link to
Form or
Table field.

record.recordExistsInField(f
ield_id');

setFieldValue()
field_id,
value

none

Sets the
value on the
specified
field.

record.setFieldValue(movie_t
itle_id, 'The Terminator');

setFieldValue()
field_id,
value,
boolean

none

Sets the
value on the
specified
field and

record.setFieldValue(movie_t
itle_id, 'The Terminator', f
alse);
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Function/Property Parameters Returns Description Example

optionally
disables
scripts that
would run
by default
when the
field value
changes if
the third
parameter
is false.

setFieldValues()
dictionary,
boolean

none

Sets the
values on
multiple
fields at
once given
a dictionary
of field ids
and values.
Second
boolean
parameter
optionally
disables
scripts that
would run
by default if
the
parameter
is false.

record.setFieldValues({
[field1_id]: "value1",
[field2_id]: "value2",
[field3_id]: "value3"

}, false);

setNoteFieldValue()
field_id,
value

none

Sets the
rich text
note field
value on the
specified
Note field.

record.setNoteFieldValue(fie
ld_id, 'note_value');

setRecordColor() web color none

Sets the
color for the
record to
the
specified

record.setRecordColor('#cc99
00');
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Function/Property Parameters Returns Description Example

web hex
color.

values none dictionary

Returns the
values in
dictionary
format that
are
associated
with this
record. The
key in the
dictionary is
the field ID.

record.values;

script
Function/
Property

Parameters Returns Description Example

getId() none script ID
Returns the internal
unique ID of the script.

script.getId();

isFavourite none boolean
Gets or sets the script
to be a favourite or not.

script.isFavourite = true;

name none text
Returns the name of
the Script.

var scriptName = script.name;

code none text
Returns the source
code of the Script.

var code = script.code;

scriptDescription none text
Returns the description
of the Script.

var description = script.scriptD
escription;

search
Function/
Property

Parameters Returns Description Example

getAvgOfField() field ID number

Returns the average
value of all the records
in the search for the
specified field.

search.getAvgOfField(fieldID);
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Function/
Property

Parameters Returns Description Example

getMaxOfField() field ID number

Returns the maximum
value of all the records
in the search for the
specified field.

search.getMaxOfField(fieldID);

getMinOfField() field ID number

Returns the minimum
value of all the records
in the search for the
specified field.

search.getMinOfField(fieldID);

getRecords() none array
Returns an array of
record objects for the
specified search.

var records = search.getRecord
s();

getTotalOfField() field ID number

Returns the total sum
of all the records in the
search for the
specified field.

search.getTotalOfField(fieldID);

name none text
Returns the name of
the Search.

search.name;

Utils
Function/Property Parameters Returns Description Example

addToCalendar()
dictionary,
start date,
end date

event
identifier

Adds an
event given
the
specified
start date,
end date,
and event
info
dictionary.

See example below

addToReminders()
dictionary,
due date

none

Adds a
reminder to
the Apple
Reminders
for the
specified
reminder

See example below
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Function/Property Parameters Returns Description Example

dictionary
and due
date.

alertWithMessage()
title,
message

none

Displays an
alert with
the
specified
title and
message

Utils.alertWithMessag
e('Script Run Complet
e!', 'Cool!!!!!');

copyTextFromClipboard() none text

Returns
whatever
text is on
the
clipboard.

Utils.copyTextFromClipbo
ard()

copyTextToClipboard() text none

Copies the
specified
text to the
clipboard.

Utils.copyTextToClipboar
d('Some text')

getDataFromUrl() url
binary
data

For the
specified
URL,
returns a
binary data
response.

var photo_data = Utils.g
etDataFromUrl(url);

getDeviceName() text none
Returns the
name of the
device.

var device_name = Util
s.getDeviceName();

getJsonFromUrl() url JSON

For the
specified
URL,
returns a
JSON
response
that you can
get values
from.

var product_info = Util
s.getJsonFromUrl(url);

getTextFromUrl() url text
For the
specified
URL,

var product_info = Util
s.getTextFromUrl(url);
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Function/Property Parameters Returns Description Example

returns a
text
response.

getUserName() text none

Returns the
name of the
user logged
in to the
device. For
iOS, returns
“Mobile
User”

var user_name = Utils.ge
tUserName();

openUrl() url none

For the
specified
URL, calls
the
operating
system to
open it.

Utils.openUrl(url);

postContentToUrlWithContentType()
text, url,
content type

dictionary

For the
specified
URL, posts
the text
content
using the
specified
content
type.

Utils.postContentToUrlWi
thContentType(some_strin
g, url, 'application/jso
n');

postJsonToUrl() JSON, url dictionary

For the
specified
URL, posts
the JSON
content.

Utils.postJsonToUrl(jso
n_string, url);

printRecordsShowPanel() boolean none

When true
passed in,
shows the
print panel
before
printing
records.
When false

Utils.printRecordsShowPa
nel(true);
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Function/Property Parameters Returns Description Example

is passed
in, prints the
current view
without
showing the
print panel.

updateCalendarEvent()

string,
dictionary,
start date,
end date

none

Given an
event
identifier
previously
provided
when
adding an
event,
update the
event
information.

See example below

updateReminder()
string,
dictionary,
due date

none

Given a
reminder
identifier
previously
provided
when
adding a
reminder,
update the
reminder
information.

See example below

Prompter class – for prompting for input.
You can also prompt a user for input parameters, then take the input and use it for populating fields. Here’s
an example:

var output = function printOut(continued) {
if (continued == true) {

console.log(username + ", " + password + ", " + email_address + ", "
+ other_field + ", " + genre);

} else {
console.log("Cancel button pressed.");
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}
}

var username = 'test username';
var password;
var email_address;
var other_field;
var genre;
var genres = ['Action &amp; Adventure', 'Comedy', 'Drama', 'Horror', 'Science Fic
tion'];

let prompter = Prompter.new();
prompter.cancelButtonTitle = 'No Thanks';
prompter.continueButtonTitle = 'Go For It!';
prompter.addParameter('Username: ', 'username', '', username)
.addParameter('Password: ', 'password', 'secure')
.addParameter('Email Address: ', 'email_address')
.addParameter('Other: ', 'other_field')
.addParameter('Genre: ', 'genre', 'popup', genres)
.addParameter('Media Type: ', 'media_type', 'picklist', 'Media Types List')
.show('Enter a Username and Password and Stuff', output);

Progress class – for monitoring the progress of long running
scripts.
You can ask Tap Forms to display a progress indicator while you run scripts that might take a while to run.
For example:

var progress = Progress.new();
function ProcessRecords(records) {

for (index in records) {

if (progress.cancelled) {
console.log('Cancelled operation');
break;

}

Note: the following parameters are valid .addParameter(label, field_name, control type,
values_list, default_value)*
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var aRec = records[index];
// do something with the record.

// update the progress indicator.
progress.updateProgress(index);

}
}

var records = form.getRecords();
progress.totalCount = records.length;
progress.currentCount = 1;
console.log('Begin');

// show the progress sheet
progress.show('Processing Records...');

ProcessRecords(records);

// dismiss the progress sheet when done.
progress.dismissProgress();

// save your changes
form.saveAllChanges();

console.log('End');

Utils.addToCalendar()
You can ask Tap Forms to add an event to your Apple Calendar programatically. When you add an event,
Tap Forms will return an event identifier which you could store somewhere, perhaps in another field that you
could then retrieve at a later date and then update the event.

function Add_And_Update_Event() {

var event_info = {"calendar_name" : "Work",
"title" : "Test Event 1",
"location" : "Big Ben, London, UK",
"notes" : "This is a note",
"url" : "https://www.tapforms.com",
"all_day" : true};
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var start_date = new Date();
// Create new Date instance
var end_date = new Date();

// Add a day
end_date.setDate(end_date.getDate() + 1);

var identifier = Utils.addToCalendar(event_info, start_date, end_date);
console.log(identifier);

// Update the calendar if you want. But you don't need to update right aft
er you've added.

// You'll want to store the identifier obtained from above somewhere (in a
nother field) so

// later on you can update the calendar entry if you wish.

event_info["title"] = "Hello Event 2";
Utils.updateCalendarEvent(identifier, event_info, start_date, end_date);

}

Add_And_Update_Event();

Utils.addToReminders()
You can ask Tap Forms to add an reminder to your Apple Reminders programatically.

function Add_And_Update_Reminder() {

// Create new Date instance
var due_date = new Date();

// Add a day
due_date.setDate(due_date.getDate() + 1);

var event_info = {"list_name" : "Work",
"title" : "Test Event",
"priority" : 1,
"notes" : "test note",
"repeat_option" : 2};

var identifier = Utils.addToReminders(event_info, due_date);
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console.log(identifier);
event_info["title"] = "Hello Reminder 2";
Utils.updateReminder(identifier, event_info, due_date);

}

Add_And_Update_Reminder();

Calling a script from a URL
You can call a Form Script from a URL when the URL is of the following format:

tapformz://script/[document ID]/[form ID]/[form script name]?key1=value1&amp;key
2=value2...

tapformz://script/db-xxxx/frm-xxxx/Test+Script?option1=A&amp;option2=B

You can click the link button on the Script Editor window to get a copy of the script URL.

Notes:

• Tap Forms documents must be within the Tap Forms Container to receive and act upon URLs. If your
document is visible on the main Database Documents window then you’re good.

• The query component of the URL must have spaces and double-quotes escaped.
• The =, &, and # characters within query values should also be percent-escaped. If this requirement is

not followed, Tap Forms may not be able to identify the target script of the URL, listing it as (null) in
the Console.

You will also have access to a special property in the Script editor called parameters.

To reference a parameter you would use this code:

var value_1 = parameters["key1"];

The parameters property will only be available when calling the script from a URL.

Here’s an example script:

function Test_Script() {
var hello_world = "Hello World!";
console.log(hello_world);
var parms = parameters;
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console.log(parms["option1"]);
var prompt = Prompter.new();
prompt.show('Does this work?');

}

Test_Script();

Console Logging.
You can log your output to the console log view with the following code:

console.log("Colour Me This!", "#c90000");

The second parameter is optional and allows you to provide a hexadecimal web colour for your output.

Testing Tap Forms script code with an incoming URL.

Call the URL from the external app once. Tap Forms will remember the parameters. You can then edit and
re-run the script within Tap Forms without resending the URL from the external app unless you make
changes to the URL. The script editor can be open while an incoming URL is received. The script will run as
usual, and output will be recorded in the Console.

The parameters global variable will contain query keys/values for the pairs specified within the URL.
Although a query pair may have existed within the previous URL action, it will not exist within the
parameters variable if the new URL does not include that pair.

The parameters global variable will revert between test runs of the Tap Forms script; i.e., if your script
changes the contents of the variable, the next time the script is run, those changes will have been reverted
to the values specified by the URL.

Last modified: Feb 20, 2023
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9. Layouts
The benefits offered by layouts are for Tap Forms power users and beginners alike. In the following
“Layouts” topics, you’ll read about how layouts function and the unique ways you can design the perfect
layouts for you.

Layouts

• What are Layouts?
• Designing Layouts

Last modified: Jun 07, 2018

9.1. What are Layouts?

With forms, there are thousands of ways to log and customize your information to better create a digital
filing cabinet for your life. By default, however, there’s only one way to view this information: the default
layout. Though helpful in presenting your information in a digestible way, the default layout may not suit your
exact needs. For this reason, we’ve built in the ability to create additional layouts.

Custom Layouts

Custom layouts are centered around the fields you’ve assigned to your records, allowing you to add
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information in a visual format. By adding your data to a canvas and controlling every aspect of how it’s
displayed, you can create an ideal presentation of what’s present in your records. Whether you’re designing
for digital or print, layouts in Tap Forms are versatile for your needs.

Layouts are found below the toolbar in the middle of the screen – listed first is the default layout, followed
by any custom options you’ve created. Additionally, the toolbar features a layout button which opens the
layout tab; this is the central location for making any changes to layouts you’ve created.

When designing layouts, much of the work comes from simple drag and drop techniques. To get started,
drag field information onto the canvas and adjust the size, color, stroke, and more. As you continue to add
information, the layout will update; the more data you add, the more useful the layout can be. For more
information on designing layouts, visit the Designing Layouts topic.

Forms are able to contain multiple layouts, and each layout will apply to each individual record within that
form. This means that the layout you create for, say, “the Hunger Games” will populate to every other movie
in your collection. And with the ability to print layouts, you can also use them for real-world applications,
too.

Last modified: Jun 07, 2018

9.2. Designing Layouts
As mentioned in What are Layouts?, use Layouts when you want to see your records in a unique way. Since
layouts are created by you, their design is also determined by your preference; whether you’d like
something complex or straightforward, Tap Forms can support what you’re looking for.

To get started, click the + button to the right of the “Default Layout” tab under the
toolbar.

This will launch the canvas for a new layout if you’re currently in Single-Column List or Photo Grid views; if
you’re currently seeing one of the other three views, you’ll need to move to the aforementioned options.
Along the right side of the window, the Layout Inspector Panel will surface to provide you the tools you
need to create the layout. This panel can be toggled as needed to declutter the interface; however, it’s a
critical piece of the interface when working with a custom layout.
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To delete a layout

1. Make sure you’re in Edit Layout mode.
2. Hover your mouse over the custom layout tab until you see the (x) button appear.
3. Click the (x) button. You’ll be prompted if you want to delete the layout.
4. Alternatively, under the Layouts menu, select Delete Layout

Much of how you design the layout is centered around text. To begin:

1. Open the Layout Inspection Panel
2. Click the appropriate field and drag it onto the canvas
3. Edit its size and shape by dragging the box’s edges
4. Adjust the font size, type, and color via the information below the layout bar
5. Work with the stroke and fill of the box inside the Layout Inspection Panel

As you continue to add things to the canvas, Tap Forms will help you keep everything looking neat and tidy

There is no undo for deleting layouts, so make sure you really want to do this.!

By checking the Create Field Titles checkbox found below the Fields list in the Layout
Inspection Panel, Tap Forms will automatically pair a label with the field dragged onto the
canvas. Labels will take the default field name, but can be changed to your preference. You
can also change the label’s font, size, color, and text alignment.

*
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using rulers and snap features.

Formatting the Document

When working with layouts, you’ll also decide the format of the document. Included are options for:

• Layout name, where you can name the custom layout to be displayed on the tab button
• Designing for screen, paper, or labels. Whereas designing for screen is optimizing for the digital

world and is best for data entry layouts, printer and labels are for more physical applications. Printer
is great for things like invoices and marketing descriptions, while labels can use more than 1000
Avery label templates or any custom labels for necessary applications

• Printers, which lets you select a printer
• Page size for resizing the paper size (Letter, Envelope, A4, etc.)
• Orientation, either landscape or portrait

As you continue to work with your custom layout, you’ll take notice of certain features that will help you
create a more robust layout. Below the toolbar are:

• A set of buttons representing the zoom level, tab order, rulers, and snap to grid functionality, and to
show or hide the text inspector bar

To adjust the tab order of your fields

1. Click the tab order button, then click the 0 that appears next to the fields.
2. Type in a new value and press the Return key to accept the new value.
3. Keep incrementing the tab order value until all your fields have a non-zero value.
4. Turn off the tab order function by clicking the tab order button again.
5. Turn off the edit layout mode by clicking the Layout button again. The layout inspector panel should

now be hidden.
6. Click in your first field on the custom layout and press the tab key. Tap Forms should follow the order

that you’ve specified with each of the tab order values. To tab out of a Note field, press option-tab.

• Layout design tools, including options for adding lines, shapes, text, or photos into your layouts

The Arrow tool lets you select, resize, and drag around the objects on your layout page.

The Line, Oval, and Rectangle tools allow you to draw lines, ovals and rectangles on the page. You can
constrain the line, oval or rectangle by holding down the shift key as you drag a handle around on the page.
You can change the stroke of a line, circle or rectangle to make it thicker or thinner. You can also change
the stroke colour of lines, ovals, and rectangles using the Graphic Properties Inspector which will appear
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when you select an object. Ovals and rectangles can also have their fill colours changed.

The Text tool allows you to create blocks of text which will stay the same on every record. This would be
useful for things like company names, addresses, or any other kind of text that you want to remain the same
on every record.

The Image tool allows you to create areas on the layout which will be filled with any image you have
available on your computer. These images will stay the same on every record. This would be good for things
like a company logo, icon, photo or any other kind of image you want to have on every record.

• Text and alignment controls like typeface, size, color, and other alignment selections

Layers
Also present in the layout designer are layer customization options, where you can see the available layers
and rearrange them up and down, including sending layout objects behind or in front of others. This is found
in the tab next to “Fields” in the sidebar. You can also adjust the tab order here by double-clicking on the 0
next to a field and typing in a new value.

You can also lock layers so they cannot be moved accidentally. To lock a layer, click the checkbox button
on the right.

Mail merge. If you enter a field name within square brackets in a static Text block, Tap
Forms will replace the field name and square brackets with the value from the field for that
record when you print your record. For example: “Dear [First Name], the amount owing on
your account is $ [Amount Owing] .”

*

The Image tool is different than a Photo field in your form. A Photo field will change its
image with every record while the Image tool’s image will remain the same on every record.*
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Last modified: Jan 02, 2023

9.3. Labels
Tap Forms has a very powerful label design engine built-in. You can select from over 1000 Avery® label
templates, customize the built-in templates, or create your own from scratch.

Before you can select a label template, create a new custom layout and choose the Labels option next to
the Design for property in the Layout Inspector panel on the right. Once you do that, you’ll see the Select
a Label button appear.

For more information, see the Designing Layouts topic.

To delete an object from your custom layout, just select it and press the Delete key on your
keyboard. This will only work when the layout inspector panel is visible so that you’re in
layout design mode. To delete the field completely from your form, click on the Form button
in the toolbar, then the Fields tab. Then click on the field you want gone forever, then press
the – button to delete it. If you do that before deleting the object from your layout, the object
on your layout will still be hanging around, but will be non-functional. So delete it from your
custom layout first and then delete the field itself.

*
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When you click the Select a Label button, the following popover view will appear:

You can filter labels by paper size or you can enter in a keyword or Avery Product Code to help you find the
label type you’re looking for. Click the Select button when you’ve found the label template you’re looking for.
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To customize the selected label or to create your own label from scratch, click on the Edit Label button.

You can also choose to print the same label per page or you can select the Multiple records per page
option which will tell Tap Forms to print a different record on each label. Printing the same record for each
label would be very useful for printing something like a Business Card where you want the same information
printed on each card. Printing multiple records per page would be perfect for printing Address Labels where
you want a different address on each label.

After you’ve selected or edited your label format, it’s time to drag fields into the layout designer area and
customize the design of your label. To get a larger view of your labels, adjust the zoom level to be higher
than 100%.

If you don’t see the Multiple Records Per Page option, drag the horizontal divider bar on
the layout inspector panel down a little bit to reveal that option.*

To print your labels, select the Print function from the File menu and make sure you have*
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Last modified: Jun 07, 2018

the Details (1 record per page) option selected. Note, if you have Multiple records per
page enabled for your label, you will still get multiple records per page printed, despite what
the Details option says.
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10. Migrate from Tap Forms 3.5
To migrate to Tap Forms 5, a backup file from the old version is required.

Decrypt the old database

Before migrating to Tap Forms 5, I recommend decrypting the database in the old version first. This will
make migrating easier. You can re-encrypt the new database document later.

Backing Up

1. Create a backup using the old version of Tap Forms* by selecting the Backup command from the File
menu

2. Save your backup file somewhere convenient, such as your Desktop
3. Launch Tap Forms 5
4. Click on the “Migrate from previous version…” option.
5. Follow the steps shown on screen

1. Choose your backup file: This is where you’ll choose the version of the database document that

You only need to migrate your database on one device. Use the Send Document function to
transfer that migrated document over to your other devices. If you do not do this, you will
not be able to sync that document between your devices.

!
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you’d like to restore into Tap Forms. By clicking the “Choose…” button and navigating to the relevant
location, you can choose the file for restore.

2. Name your new document: Type in the name of your new document. This can be the previous
document’s name or something new.

3. Ignore the instructions in the app, I suggest decrypting your database in Tap Forms 3 before migrating
the backup file in Tap Forms 5.

Once you’ve completed the above steps, you’ll be on your way to working with your old data in Tap Forms 5.

Last modified: Oct 28, 2021

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en

Page 90 of 158



11. Relationships
Tap Forms has the ability to link forms together to establish relationships between them. There are currently
three types of links:

1. One to Many
2. Many to Many
3. Join

To make it easier to identify what is being talked about in this section of the documentation, I’ll refer to the
main form as the parent form. Any form that the main form links to will be called the child form.

One to Many

The One to Many link type is useful in situations where the child form’s data is unique to the parent record
it’s linked to. That is, no two parent records should link to the exact same records from the child form. It’s
easiest to describe this situation using an example.

Keeping Track of Clients and Expenses

If you wanted to keep track of all the expenses you incur when working for a specific client, you wouldn’t
want those expenses to be linked to any other client than the one for whom you are currently working. A one
to many relationship is useful in this situation. One client has many unique expenses which are attributable
only to it.
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Create a Client Expenses form:
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Create a Clients form and link it to the above Client Expenses form:
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Make sure you’ve selected One to Many as the Link Type.

Now when you add or edit a record on your Client form, you can see the list of Client Expenses. Initially
there will be none, but you can click the + button below the list of Client Expense records to add one.
Clicking the + button will add a record inline in the table view. Clicking the +> button will take you to the
Client Expenses form where you can fill out the details there. By adding a record from this view Tap Forms
will link the new Client Expense record to the parent Client record.

When you add a child record to the parent record form, Tap Forms will switch the display to the child form
(in this case Client Expenses) along with a back button which when clicked will return you to the parent
record from where you came.

A note about the Show Inverse Relationship option. You can enable the Show Inverse
Relationship option if you would like Tap Forms to manage both sides of the relationship for
you. Enabling the Show Inverse Relationship option will automatically create a Link From
Form field which will show you which parent record linked to the record you’re viewing. In
our example that means a Client Expense record will display a field that links back to the
Client form so for any selected Client Expense record, you’ll easily be able to see which
Client it belongs to.

*

Don’t create your own Link From Form field. Tap Forms will create it and set it up properly
for you when you enable the Show Inverse Relationship option.

!
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Many to Many

An example of a Many to Many link could be a list of team members who are assigned to projects for the
selected Client. A team member can work on multiple projects, so a many-to-many relationship makes
sense here. They may work on only one project at a time, but over time they may have worked on various
projects, so using a many-to-many relationship allows you to keep that historical information as you look
back through old projects.

Add a Team Members form that contains a list of people that work at your company. You could add their
name and job title.

Now add the linked form field to the original Clients form:
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Make sure you click on Many to Many for the Link Type and select the Team Members form from the Link
to Form property.

Now when you view your Client record the list of Team Members will initially be empty:
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After you’ve added some Team Members you’ll be able to select from the list of Team Members by
clicking on the checkmark button just below the linked field.

This will display a popover with a list of child records which haven’t yet been linked to your parent record.
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Select one or more records from the popover and then click the Select (#) button.

The list of linked records will update to show the records you’ve previously selected and the records you’ve
just selected.

And that’s the difference between a One to Many and a Many to Many Link to Form field.

Join

The Join Link Type option allows you to join two forms together based on some criteria that’s common
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between the parent and child forms. An example might be if you have an Orders form and an Order Items
form. The parent Orders form would typically have an Order Number field. The child Order Items form would
also have an Order Number field.

The Join Link Type can be used to make a connection between the Orders and the Order Items form by
matching the Order Number field from both forms. That means that for any Order record, Tap Forms will
display a list of Order Items that match the Order Number field in both the Order and Order Items forms.
Currently the matching criteria checks if the values of Text type fields are equal in a case insensitive way.

Last modified: Feb 20, 2019
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12. Backup & Restore
Keeping regular backups is critical to the operation of any computer system. This is especially true for an
application like Tap Forms because often your most critical day-to-day information is stored there.

Tap Forms offers a simple method to backup your database documents to make sure you are always able to
recover if things go wrong or if items are accidentally deleted. It happens.

To backup your documents, on the macOS version you have two options.

1. The Backup command in the File menu.
2. The Backup on Quit function on the General Preferences window.

The Backup Command

This is fairly straight forward. You select the Backup command from the File menu and choose where you’d
like to save the backup file. Tap Forms will zip the currently opened document and name it with the current
date and time the backup file was made.

Backup on Quit

A handy way of letting Tap Forms backup for you is when you’re quitting the app. If you leave a document
opened and then quit Tap Forms, the Backup on Quit function will be triggered, creating a backup file in the
chosen Backups Folder location. To configure the Backup on Quit function, go to the Preferences window
and click on General if it’s not already selected. There you can enable the Backup on Quit function set how
many backups you’d like to keep, and specify a folder where Tap Forms will save your backup files. It would
be a good idea to set that to something such as an iCloud Drive or Dropbox folder. That way when Tap
Forms backs up, the backups will then be stored in your selected cloud storage location.

Restore
Restoring is a little more complicated if sync is involved. This is because if you’re syncing and you restore
your backup file, when sync happens again, whatever things in your document were deleted, will also be
deleted again. So to avoid this you must disable sync on every device before you restore.

Here are some steps you can follow if you’re syncing using iCloud:

1. Open the document on your Mac and other devices.
2. Disable iCloud sync on each device.
3. Press the Delete from iCloud button on just one device.
4. Close the document on your other devices.
5. On the Mac, re-enable sync.
6. Wait for sync to finish.
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7. Close the document on the Mac.
8. Re-open the document on the Mac.
9. Wait for the second sync cycle to complete.

10. Close the document one more time on your Mac.
11. Delete that document from your other devices.
12. Use the Send Document function from the Mac and send it to all your other devices.
13. Open the document on your other devices one at a time.
14. Re-enable sync on the other devices one at a time.

If you’re using other sync services such as IBM Cloudant or Apache CouchDB, you must login there and
manually delete the database document that matches the Document ID you see on the Sync Settings
screen. The Document ID is the “db-…..” value you see on the Sync Settings screens in Tap Forms.

To backup on the iOS version

1. Open the document you want to backup.
2. Tap on the Tools tab.
3. Tap on the Backup & Restore function.
4. Tap on the + button to make a new backup file.
5. Tap on the backup file to select it.
6. Tap on the Upload button.
7. Choose a location where you would like to upload your backup file to so its available on other devices.

To restore on the iOS version

1. Open the document you want to backup.
2. Tap on the Tools tab.
3. Tap on the Backup & Restore function.
4. Tap on the Download button.
5. Locate your backup file in your cloud storage service and tap on it to download it to Tap Forms.
6. Tap on the backup file.
7. Tap on the Restore Backup button.

You should also disable sync on the iOS version before you restore to it. And make sure that you restore
only to one device and then use the Send Document function to send the restored document around to your
other devices.

Last modified: Jul 02, 2020
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13. Syncing
Syncing is critical to making sure your data stays safe and functional across all devices. In the “Syncing”
topics are explanations on how to sync your data using a slew of methods.

Syncing

• Nearby Sync
• iCloud Sync (requires all devices to be logged in to the same Apple ID)
• IBM Sync
• Apache CouchDB Sync

Last modified: Jan 10, 2020

13.1. Send Document to Another Device

Before you can sync, use the Send Document function to send a copy of your document to
your other devices.*
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When syncing your database documents between devices, you must have identical documents on both
devices. After migrating the database on one device, you can send the migrated documents to your other
devices via AirDrop or iTunes File Sharing. This process can take place on both the Mac and iOS.

The simplest way to send files between devices is through AirDrop. Both iOS and Mac have options to
AirDrop your documents; to get started, make sure both of your devices are AirDrop compatible, are set up
on the same Wi-Fi network, and are within close proximity. After checking these factors, follow the steps
below.

Sending with a Mac

1. Launch Tap Forms on both devices.
2. Display the Database Documents window by pressing command-0 (zero) or selecting Database

Documents from the Window menu.
3. Click the database document you’d like to share. Do not open the document. If it’s already opened,

close it first and make sure the main Database Documents window is in the foreground.

4. At the bottom of the window, click the “Share” button. You can also use the Send Document
command in the File menu.

5. Select the device to which you’d like to send the document. If you don’t see your devices listed there,
make sure AirDrop is enabled and they are nearby and turned on.

Sending with iOS

1. Launch Tap Forms on both devices.
2. Tap the action menu button at the top left of the screen (next to the “+”).

If you have an opened document in Tap Forms for iOS, please close it first. Tap the (v)
button at the top-left of the My Forms tab to close it. You should be on the main Documents
view.

!

iOS 17 users will see the document appear inside the Files app instead of going directly to
Tap Forms after the transfer. You will need to tap on the document if it’s not already
displayed, then tap on the Share button, then tap on Tap Forms on the share sheet to have
the document transferred to Tap Forms. Apple made this change and Tap Forms has no
control over that part of the process.

!

If you’re sending the document to a Mac, the file will automatically be sent to your
Downloads folder in the Finder. Drag it to the main Database Documents window to insert it
into Tap Forms. When dragging a Tap Forms document into the Database Documents
window, let go of the mouse when you see the blue horizontal line appear in between
documents.

*
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3. Tap “Send Document”.
4. Choose the file you want to share.
5. Locate the device in the AirDrop section and tap on it to send it over.

iTunes File Sharing

If your devices aren’t compatible with AirDrop or you’d prefer an alternative
method, you can also use iTunes File Sharing to send a file between iOS and Mac.

1. Launch iTunes and plug your device into your Mac
2. Click on your device in iTunes

On iOS, you can also share your document by means other than AirDrop, like Messages,
Mail, etc.*
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3. Find the iTunes File Sharing area. In recent versions of iTunes, there’s a separate File Sharing area.
However, on older versions of iTunes, you have to navigate into the Apps area and then scroll all the
way down until you see the File Sharing area.

4. Scroll down to find Tap Forms in the list of apps and click on it.
5. You will see the Tap Forms Documents area appear on the right.

6. Drag a .tapforms document file from your Mac into the Tap Forms Documents area on the right in
iTunes.

7. If you’re wanting to copy from an iOS device to your Mac, drag the file from iTunes to your Mac.

Now that you have the same document on each device, you may now proceed to setting up either Nearby or
Cloud syncing.

Last modified: Jan 23, 2024

13.2. Nearby Sync
Nearby Sync uses your own local area network (either WiFi or hard wired) to sync a document to that same
document on your other devices. Your data does not travel over the Internet in order to accomplish this. It
stays on your own local area network which means that it does not require a cloud service to function.

If you select a file in iTunes, pressing the Delete key on your Mac’s keyboard will delete it
from your iOS device.*
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However, all devices must be attached to the same network to it to function. Also, if your Mac has its firewall
enabled, you must allow Tap Forms to accept incoming connections or Nearby Sync will not function.

To configure synchronization with nearby devices via Wi-Fi:

1. Open the same database document on each device you want to sync with.
2. Under the Tap Forms menu, select Preferences.
3. Click Sync.
4. Click Nearby.
5. If the device isn’t listed, click the + button.
6. Select the device. You will see a green dot appear next to the device you added.
7. Click Done.

Do the same on all of your devices so that Tap Forms on each device is connected to each other.
You will need to do this with every database document that you want to sync with each of your other
devices.

It’s also possible to have some devices syncing one document and other devices syncing other documents.
For example, you may want to sync your private information with just your devices, but sync your shared
information with a family member or co-worker with one or more of their devices.

Last modified: Feb 20, 2019

13.3. iCloud Sync
Tap Forms 5 supports syncing your database documents via Apple’s iCloud servers.

Before you can sync, you must have a copy of the same document open on each of your
devices. Use the Send Document function to transfer a copy of your document from one
device to another. See the Send Document to Another Device topic for instructions.
*

Each device must be on and have the same database document open at the same time in
order for Nearby sync to function. The moment you make a change on one device,
synchronization will begin on all your devices.
*

If a device doesn’t show up, check the length of your device names. They should be no
more than 25 characters. For example, if a device was called “Brendan Duddridge’s iPhone
6 Plus”, that would be 33 characters. This will cause the device not to show up in the list
even if it has the same document open. This is due to a networking issue where devices on
the network can’t have names longer than 63 characters. Tap Forms prefixes the device
name with the document ID which is already 35 characters, plus an @ character.

*
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Before you can sync with iCloud, you must:

1. Be logged into your iCloud account.
2. Have iCloud Drive enabled.

To setup iCloud sync on Mac:

1. Create a new document or open an existing one
2. Click Preferences under the Tap Forms Mac menu
3. Click Sync
4. Select iCloud from the list of sync services
5. Click the Enable iCloud Sync button

To setup iCloud sync on iOS:

1. Create a new document or open an existing one.
2. Tap the Tools tab at the bottom-right of the screen.
3. Tap Sync Settings.
4. Tap iCloud on the buttons at the top. It’s the first button with the little i in it.
5. Tap the Enable iCloud Sync button

Tap Forms will then upload the forms and records in your document to iCloud. You should see messages
appear at the bottom of the window on the Mac version indicating when Tap Forms is sending and receiving.
The iOS version will display sync messages on the Tools screen. Tap Forms will also generate an empty
document placeholder on your other devices that are connected to the same iCloud account. You’ll see a
cloud icon with a down arrow in it.

Wait for Tap Forms to finish uploading to iCloud before you proceed.

When you open the placeholder document on your other device, after a few moments, Tap Forms will
download from iCloud and all your data for that document will be synced. If for some reason not all the data
comes down, I would recommend using the Send Document function to send a copy of the document you
just synced over to your other devices. If the same document already appears there, remove it first, then
use the Send Document function to send it over from the device that has all the data. That way you ensure
an exact copy of the document is on all your devices.

There is also a “Delete from iCloud” button. This button allows you to delete the contents of the document
from your iCloud account, helping to free up your iCloud storage space should you no longer wish to sync
that document. Deleting the document from iCloud will not delete it from your local drive. It can be handy
occasionally to delete the document from iCloud and then re-enable sync to have Tap Forms re-upload the

If you don’t see the placeholder document appear on your other devices, try rebooting your
device. Occasionally, the notifications that iCloud sends don’t get delivered to Tap Forms,
so it doesn’t know about the new document. Rebooting may help this.
*
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entire document.

Last modified: Sep 08, 2020

13.4. IBM Cloud

For instructions on syncing with nearby devices over Wi-Fi, see the “Nearby Sync” topic. For instructions on
syncing with iCloud, see the “iCloud Sync” chapter. For instructions on setting up your own Apache
CouchDB sync server, see “Apache CouchDB Sync”.

When Tap Forms is downloading data from iCloud, it does so in batches of 200 items. It
repeats this over and over again until it’s done. Please let it finish. The first sync usually
takes the longest and it depends on how much data you’re syncing.
*

If iCloud doesn’t automatically update on your iOS device when a change is made on
another device, go to Settings &gt; General &gt; Background App Refresh and
make sure that Tap Forms is enabled for Background App Refresh.
*

IBM has recently updated their Cloudant service to require customers to create a new IBM
Cloud account. If you already have an old Cloudant account, you must create a new
account on the new IBM Cloud service, and then set up the sync again using the new
service. You don’t need to follow the instructions they gave you for migrating your data to
the new account. You only need to sign-out of Cloudant within Tap Forms, then sign-in
again using the new credentials you’ll be given once you follow the instructions here.

!

IBM has also now changed the domain they use for the address field, so I recommend using
the Apache CouchDB login in Tap Forms instead of the Cloudant login screen and pasting
in the host value from the service credentials into the Server Address field in Tap Forms.

!

Also please note that IBM has implemented an 11 Megabyte request size limit for syncing
with their service. This means if you have content, photos and file attachments in your
records that add up to more than 11 MB, IBM will respond with a “request entity is too
large” error during syncing. Tap Forms for Mac will display the record which causes the
error to happen so you can take appropriate action to remove the image or attachment
causing the error. Please contact support@cloudant.com if you receive this error message.
If this becomes a problem for you, you will need to switch to iCloud, Nearby, or Apache
CouchDB syncing instead. IBM has recently increased the limit from their previous 1 MB.
Specific details are here: https://console.bluemix.net/docs/services/Cloudant/offerings/
bluemix.html#request-and-document-size-limits

*
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IBM Cloud syncing is very useful if you want to sync with someone who does not share the same Apple ID
as you on their devices.

Here are the steps you need to do to create an IBM Cloud account and to add Cloudant as a service into
your account. You’ll need to do this first before you setup Tap Forms with your username and password
given to you by IBM Cloud now.

Visit https://cloud.ibm.com/catalog/services/cloudant to create your account.

1. Scroll down to Pricing Plans.
2. Select a pricing plan. Try the free Lite service first to see if that works for you. If your storage

requirements are higher than 1 GB, then you may need to select the Standard plan, but there will be a
fee for that. If you’re not comfortable with that, you can certainly use one of the other built-in sync
solutions in Tap Forms.

3. Click on the blue Sign Up to Create button on the right.
4. In the Email field, enter your email address, and then press the tab key.
5. Enter your remaining details including a password that you will use to login to your IBM account on

their website. You will not be asked to type your password in again. Please remember it. Also please
note this is NOT the same password you use to Sign In to Cloudant within Tap Forms. That will be
issued to you later on.

6. Click the Create Account button. You will be asked to check your email to verify your email
address.

7. Look for an email in your email account titled: Action required: Confirm your IBM Cloud a
ccount.

8. Click the blue Confirm Account button.
9. You should see a Success! screen.

10. Click the Login button to proceed.
11. Enter your login email address and password when prompted.
12. View the welcome splash screen and click the Next button or click the X button to close it.
13. You should see the Cloudant NoSQL page.
14. Click the blue Create Resource button on the page.
15. If you have the choice of Available authentication methods, you MUST choose the Use bot

h legacy credentials and IAM. If you don’t choose that option, you won’t get a username and
password from the next step.

16. Click Service credentials on the left where it says Manage, Service Credentials, Plan and

Before you can sync, you must have a copy of the same document on each of your devices.
Use the Send Document function to transfer a copy of your document from one device to
another. On Mac, click on the Share button at the bottom of the main Documents window.
On iOS, tap on the share button at the top of the main Documents view and select “Send
Document”. Once you have the same document open on each device, then you can setup
sync between them. Tap Forms must be running on each device and have the main
Documents view visible in order for the transfer to take place. See the “Sharing with Another
Device” topic for more information.

*
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Connections.
17. Click the blue New Credential button on the right.
18. Accept the default name and then click the blue Add button.
19. Click the dropdown arrow next to View Credentials and copy the username and password

values. These are the user name and password values you will need to enter into Tap Forms in the
next step. For example, a username is similar to this: username: 7891234-qll3-lk92-woiu4-da0
d345tg7b5-bluemix.

20. Copy the username and password values EXCLUDING the double-quotes.
21. Now click Manage at the top-left side of the page.
22. Click the Launch button if you wish to view your Cloudant dashboard. This is where you can see your

databases that you’re syncing with Tap Forms once you’ve signed in to your IBM Cloud account within
Tap Forms.

Once you have your own IBM Cloud Cloudant service setup, you need to return to Tap Forms on each of
your devices that are being synced and go through the following steps:

1. Open the database document you would like to sync.
2. Under the Tap Forms menu, select Preferences. On iOS, go to the Tools area then tap on Sync

Settings.
3. Click Sync.
4. Click Cloudant.
5. Copy the username value given to you from the Service Credentials in your IBM Cloud account.
6. Paste the username value given to you into the Tap Forms Username field. When you paste in your

username, the server address will automatically be entered for you.
7. Copy the password value given to you from the Service Credentials in your IBM Cloud account

and paste it into the Password field in Tap Forms.
8. Enable Auto-Sync if you wish to have Tap Forms sync your data automatically.
9. Click the Sign In button when you’re done.

Auto-Sync

If you enable Auto-Sync, Tap Forms will sync with Cloudant automatically whenever you make changes.
Any other device which is also running Tap Forms at that time will receive any changes you’ve made a few
moments later. If no other devices are running Tap Forms at that moment, the next time you launch Tap
Forms on those other devices, they will check Cloudant for any changes and will sync. If they have changes
that have not yet been synced to Cloudant, those changes will also be automatically synced.

If you’re not using Auto-Sync, select the Sync Now command from the File menu whenever you want to

Auto-Sync is a great way to make sure you are always accessing the current data
regardless of the device. However, this function may not be suitable for multi-user
synchronization, as all users will be interrupted briefly while Tap Forms synchronizes the
changes.

*
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sync your document.

Database Sharing

Cloudant has the ability to let you share a database with another Cloudant user. Tap Forms supports this via
the Shared by user setting on the cloud Sync Settings screen. Once you’ve setup database sharing and
granted the other Cloudant user access to your database, the other user will need to enter your username
into the Shared by user setting in Tap Forms. They also need to enter their own username and password
into the appropriate fields. Once they’ve done this, any changes they make to their copy of the database will
be synced with your copy of the database and vice versa.

Last modified: Jan 20, 2022

13.5. Apache CouchDB Sync

Please note: Tap Zapp Software Inc. has no access to your data. Your data is stored and
managed solely by IBM Cloudant. Please see IBM’s Privacy Policy here:
http://www.ibm.com/privacy/details/us/en/
*

This is an advanced topic which describes how to install and setup your own CouchDB
server. Running your own CouchDB server will allow you to have your own sync solution
within your own network without incurring the limitations of Nearby sync. You won’t have to
have the same document opened at the same time for sync to function. All changes made
on all your devices will be stored in your Apache CouchDB server. The primary audience for
this sync solution is anyone who doesn’t want their data to be stored on a server outside
their home or office location.

!
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What is Apache CouchDB?
Apache CouchDB is a free, open-source database server which employs the same Couch Replication
Protocol that Tap Forms uses to sync with IBM Cloudant. This means that Tap Forms is able to sync with
your own server hosted in your own home or office without incurring the expense of an outside cloud based
sync service.

Where can I get CouchDB?
Apache CouchDB can be downloaded from the following location:

http://couchdb.apache.org

Installing CouchDB
This topic will guide you through installing and setting up Apache CouchDB on a Mac. For other platforms,
see the Apache CouchDB website for help.

1. On the Apache CouchDB website, click the Download button at the top of the page.
2. Click on the button to download CouchDB for Mac OS X (10.10+)
3. In the Finder, double-click on the Apache-CouchDB ZIP file to uncompress it.
4. Drag the Apache CouchDB.app file into your Applications folder.

Setup
1. Run the Apache CouchDB application.
2. Open up the CouchDB admin web page. It should launch your web browser and take you to the admin

page automatically. You may recognize it because it looks very similar to the IBM Cloudant
Dashboard. If it doesn’t launch, you can select Open Admin Console from the CouchDB menu that
will display in your menubar.

3. Verify the install by clicking on Verify, then Verify Installation. You should see checkmarks next to
each entry.

4. Click on Admin Party! then create an admin account.
5. Click the Create Admins button to do that. Then give the admin a username and password.
6. Click the Save button when done.

If you see an entry for bind address, make sure it’s set to 0.0.0.0 or else you won’t be able
to connect to it from other devices.*
Only admins can create databases. Because only admins can create databases, if you try to*
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To create non-admin regular users
It’s not as straightforward to create a regular user with CouchDB. We’re not sure why they don’t have a
proper interface for creating regular users, but it’s simple enough when you know how.

1. Click on the Databases button in the CouchDB admin page.
2. Click on the _users database. If the _users database does not exist yet, make sure you went

through the Setup process first.
3. Click the (+) button and then select the New doc function. A new record will be created in the _users

table for you with a default value.
4. Remove the default value.
5. Copy and paste in the following code (including the curly braces) into the record.
6. Replace username in both spots with the username you want to create. Don’t use any special

characters in the username. Just letters and numbers. No spaces or punctuation.
7. Replace plaintext_password with a proper password.

{
"_id": "org.couchdb.user:username",
"name": "username",
"type": "user",
"roles": [],
"password": "plaintext_password"

}

8. Click the Create Document button when you’re done. The password will automatically be encoded
into a more secure derived_key and salt format when the document is created. This means
anyone looking at the _users database will not be able to tell what the password is.

Configure CouchDB for Single Node Setup
CouchDB can be used in a single-node and cluster setup configuration. A single-node CouchDB installation
is what most users will be using. For more advanced setups, consult the online documentation at
https://docs.couchdb.org/en/stable/

sign in with a regular user account and the database hasn’t been created in CouchDB yet,
Tap Forms will display an error indicating the database does not exist. You can temporarily
sign in as an admin to create the database or you can use the CouchDB admin console to
create a database with a matching ID number you see on the Sync Settings screen in Tap
Forms. You’ll know the ID number when you see it since it starts with “db-” and has a bunch
of random letters and numbers after it. Copy that to the clipboard and paste it into the
CouchDB admin console when creating your database.
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1. Click the Setup button. You will be asked to set up CouchDB as a single-node instance or set up a
cluster.

2. Click the Single-Node-Setup button. You will be asked for an admin username and password.
Choose them well and remember them. You can also bind CouchDB to a public port, so it is
accessible within your LAN or to the public.

Once you’ve done this you will be able to connect to your new CouchDB server from within Tap Forms
running on other devices.

Setup Tap Forms 5 for Mac
1. Launch Tap Forms and open the document you want to sync.
2. Click Preferences under the Tap Forms menu.
3. Click the Sync tab.
4. Click the Cloudant & CouchDB button.
5. Click the Service Provider popup button and choose Apache CouchDB.
6. Enter the IP address of your CouchDB server in this format: http://127.0.0.1:5984. If you’re

running your server on the same computer that Tap Forms is running on, use the IP address 12
7.0.0.1. Don’t forget to add a : followed by the port number 5984 after the IP address. If your
CouchDB database is on a different server, then use that server’s IP address instead.

7. Click on the Auto-Sync checkbox to enable automatic syncing.
8. Click the Sign In button to sign-in to your new CouchDB server. The sync process will now begin.

Setup Tap Forms 5 for iOS (for local area network syncing
only)

1. Launch Tap Forms on your iOS device and open the document you want to sync.
2. Tap the Tools tab.
3. Tap the Sync Settings function.
4. Tap the far right Cloud button.
5. Tap CouchDB next to the Cloud Service option.
6. Tap the Server field and enter the IP address of your CouchDB server in this format: htt

You will need to use http instead of https if you’re connecting to an IP address. If you
would prefer to connect to a named server, for example https://couchdb.mycompan
y.com:6984 then you’ll need to make sure you use https and you have the appropriate
SSL secure certificate installed on that server. The default port number for https
connections is 6984. By using an IP address instead of a named server, you can avoid
needing to setup an SSL certificate. However, syncing between Tap Forms and your
CouchDB server will NOT be secure. It’s preferable to setup the appropriate SSL
certificates on your CouchDB server so you can sync securely.

!
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p://0.0.0.0:5984. Replace the 0.0.0.0 with the actual IP address of your own CouchDB server.
Don’t forget to add a : followed by the port number 5984 after the IP address.

7. Tap Auto-Sync to enable the Auto-Sync function.
8. Tap the Sign In button to sign-in to your database. The sync process will now begin.

Your Mac and iOS devices should now be syncing to your CouchDB server. There’s nothing more you need
to do.

Optional, but highly recommended: Configure CouchDB to
accept SSL secure connections
Configuring CouchDB to use SSL connections is more complicated. See the following page in the CouchDB
documentation for more information:

How Do I Configure SSL (HTTPS) in CouchDB?

If you’re running your own CouchDB server on your own network or even on the same Mac you run Tap
Forms on, then you can generate a Self Signed SSL Certificate to enable secure connections to the
CouchDB server. However, to be truly secure you should obtain an SSL certificate from a valid Certificate
Authority.

Here’s how you generate a Self Signed Certificate:

1. Launch the Terminal application
2. Generate a private key by copying and pasting the following line into the Terminal application window.

Press the Return key after every line you copy and paste.

openssl genrsa -out couchdb.key 2048

3. Generate a certificate signing request

openssl req -new -key couchdb.key -out couchdb.csr

4. After the above command is entered, your Mac will ask you a series of questions. Here’s an example:

You are about to be asked to enter information that will be incorporated
into your certificate request.
What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.
-----

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en

Page 117 of 158

https://cwiki.apache.org/confluence/pages/viewpage.action?pageId=48203146


Country Name (2 letter code) [AU]: CA
State or Province Name (full name) [Some-State]: Alberta
Locality Name (e.g., city) []: Calgary
Organization Name (e.g., company) [Internet Widgits Pty Ltd]: Tap Zapp Software I
nc.
Organizational Unit Name (eg, section) []:
Common Name (e.g. server FQDN or YOUR name) []: voyager.local
Email Address []:
Please enter the following 'extra' attributes
to be sent with your certificate request
A challenge password []:
An optional company name []:

The most important part of the above questions is the Common Name value. Since my computer is called Vo
yager, I put in voyager.local for the Common Name setting. You can find out what your computer name
is by launching the System Preferences application and clicking on the Sharing preferences panel
button. The value you’re looking for is right beneath the Computer Name setting where it says Computers
on your local network can access your computer at: Voyager.local

5. Create the self signed certificate using this shell script:

#!/bin/bash
# Set abort on error and trace.
set -e
set -x
# Use short hostname and append '.local' to get name
# Change this if you want to use another hostname.
HOSTNAME=$(hostname -s).local
# Delete CouchDB files
rm -rf couchdb*
# Create new key
openssl genrsa -out couchdb.key 2048
# Create new CSR
COUNTRY="Your Country Code e.g. US, CA, DE, etc."
STATE="Your State"
CITY="Your City"
ORGNAME="Your Organization Name"
openssl req -new -key couchdb.key -out couchdb.csr  -subj "/C=$COUNTRY/ST=$STATE/
L=$CITY/O=$ORGNAME/CN=$HOSTNAME"
# Create new cert
openssl x509 -req -sha256 -days 735 -in couchdb.csr -out couchdb.crt -signkey cou
chdb.key -extfile <(printf "extendedKeyUsage = serverAuth \n subjectAltName=DN
S:$HOSTNAME \n basicConstraints = CA:TRUE")
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Set the COUNTRY, STATE, CITY, and ORGNAME variables to your own information.

6. Copy the couchdb.key and couchdb.crt files to a location where CouchDB can find them.

Configure settings in CouchDB

1. Back in the CouchDB admin webpage (Fauxton) on your computer, click the Configuration button.
2. Click the Add Option button.
3. Enter in the following options:

Section ssl

Name cert_file

Value /Path/to/couchdb.crt

Section ssl

Name key_file

Value /Path/to/couchdb.key

I found that when following the above instructions, I had to add a couple of more settings to prevent
CouchDB from failing to startup after I edited the configuration.

Section ssl

Name ciphers

Value undefined

Section ssl

Name secure_renegotiate

Value undefined

Section ssl

Name tls_versions

Value undefined

Optional settings to protect access to some basic functions that return information about your
CouchDB installation, such as the list of database names.
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Section chttpd

Name require_valid_user

Value true

Section couch_httpd_auth

Name require_valid_user

Value true

There may be more appropriate values, but this worked for me.

The last setting must be added inside the following file (for CouchDB 2.1.1):

/Users/[your username]/Library/Preferences/couchdb2-local.ini

[daemons]
httpsd = {chttpd, start_link, [https]}

Once you’ve got your SSL certificate and key all setup and configured, you can use the name of your
machine instead of the IP address inside Tap Forms. For the above example, I would use https://voyag
er.local:6984 to connect because Voyager is the name of my MacBook Pro.

To connect from iOS to your CouchDB server over SSL
Before you can connect to your CouchDB server using the name of your server (e.g. https://voyager.l

You will not be able to logout of the admin console when you add the above setting because
your browser will log you in again if it remembers the username and password.

!

If CouchDB gets stuck trying to launch over and over again, you can find the configuration
file in this location on your drive and delete it:
/Users/[your username]/Library/Preferences/couchdb2-local.ini
You will need to quit CouchDB first before you delete that file. Click the CouchDB menu in
the menubar and select the Quit Apache CouchDB command.

*

Please note that to connect to a CouchDB over SSL, you need to use port number 6984.
Although you can actually change that in the configuration in the CouchDB admin interface.*

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en

Page 120 of 158



ocal:6984), you must first install the couchdb.crt file on your iOS device.

To install the SSL certificate on your iOS devices:

1. Email the couchdb.crt file from your Mac to your iOS devices.
2. Tap on it in the Apple Mail app.
3. The Settings app will launch and you will be taken to the Install Profile screen.
4. Follow all the prompts to install the certificate on your device. There’s lots of taps. You may be asked

to enter your device password at some point.
5. Go to Settings > General > About > Certificate Trust Settings.
6. Tap on Enable Full Trust For Root Certificates to enable it for your certificate.

The certificate will show up in the Settings app under General > Profiles. You may have other
profiles there, but the one for your CouchDB server that’s using a self signed SSL certificate will have the
name of your server. In my case that’s voyager.local.

Now you can use https://voyager.local:6984 for the server name on the Apache CouchDB sync
settings screen in Tap Forms 5. Use your own server name of course.

To connect from another Mac to your CouchDB server using
SSL

1. Copy the couchdb.crt file to all your Macs.
2. Double-click on the couchdb.crt file in the Finder. It will launch The Keychain Access application

and install it there for you.
3. Double-click on your certificate in the Keychain Access application. A window with the certificate

information will appear.
4. Click on the triangle at the top to expand the Trust section.
5. Select the Always Trust option next to When using this certificate.

To connect to your CouchDB server from the Internet
The above instructions help you to install and connect to a CouchDB server running on a Mac in your local
network. If you want to be able to connect to your CouchDB server from the Internet, you’ll need to do a few
things.

1. Open a hole in your firewall to allow traffic on port 6984 to be routed to your Mac running Apache
CouchDB. How you do this will vary depending on what kind of Internet router you have.

2. Create a new SSL Certificate so it uses a fully qualified domain name. E.g. couchdb.yourcompan
y.com. You can either generate another self signed certificate or purchase an SSL certificate from a
trusted authority, such as GoDaddy.

3. Configure a DNS service to resolve couchdb.yourcompany.com to the IP address of your network. If
you have a dynamic IP address provided by your ISP, you can use a free service like
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http://freeddns.noip.com
4. Configure Tap Forms to connect to https://couchdb.yourcompany.com:6984 (use whatever

DNS name you’ve given your server).

Last modified: Nov 26, 2021

If you want to use the same server address when connecting to CouchDB on both the inside
and outside of your local area network, you’ll need to configure a DNS server on your local
network to return the local IP address of your CouchDB server (e.g. 192.168.0.5). This is
very useful if you use MacBooks and iOS devices both inside and outside of your local area
network. Your Macs and iOS devices will also have to be configured to use your local
network’s DNS servers.

!
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14. Importing and Exporting
Much of the information you input into Tap Forms can be imported and exported using the tools provided
within the app. Additionally, Tap Forms offers integration with Bento, also outlined in this set of topics.

Importing and Exporting

• Importing
• Exporting
• Bento Template Importer
• Bento Fields in Tap Forms

Last modified: Jun 07, 2018
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14.1. Importing

Rather than recreating data you’ve already stored elsewhere, Tap Forms allows for simple importing via
Tap Forms Archive, Form Template, Records, Bento Template, or Contacts. Found under File, importing
can help you quickly develop your forms, add hard-to-copy data, and streamline your workflow.

In this topic, we’ll cover how to import records into your database documents, and it all starts with a CSV or
Excel XLSX file. By importing one of these file types, Tap Forms can understand the data within the file and
convert them into records with field data. Utilizing the top row of your file as the field types, Tap Forms can
seamlessly integrate your fields into a new form.

If the Import Records option is greyed out, please make sure you have a document already*
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Before you import your files, it’s important to take proper inventory. First, make sure that if you’re using a
CSV file, it has either a .csv, .txt, .mer, or .tsv file extension. Then, check that you know the comma
delimiter settings. If you’re importing a XLSX file, you don’t have to worry about comma delimiters, line
endings, or file encodings – just have your data in the first data sheet.

Once you’re ready to go, click File > Import > Records. To start, choose the file you’d like to import into
Tap Forms; if your records have attachments or photos, you can select those as well. Next, it’s time to
select specific settings for your file.

File Encoding

Perhaps the most important of these settings is under “File encoding”. Essentially, selecting the right
encoding format will ensure that the characters within the file are viewable and understood by Tap Forms.
It’s unlikely that you’ll have problems with this, and the default of Unicode (UTF-8) will likely suit your
needs. However, if you write in a language with specific characters, you might have to tinker with these
settings.

Comma Delimiter, Date Format, and Time Format

These three settings are important for the correct formatting of your data, but are probably already set to
your default method. In some instances, there may be conflicts – like if your date format was entered in
another country or your time value has seconds included – so make sure to double check both your file
and these defaults.

Select a Form

If you’re importing records into a form you’ve already created in Tap Forms, you can use the dropdown
menu to identify and select this form. You can also create a new form with a title here.

Assign Field Types

Finally, it’s time to assign field types to your records. If you want your records to be outfitted with unique
field types (check boxes, ratings, etc.), this is the place to do that. This certainly comes in handy when
importing records from another Tap Forms document, as you’ll already know what field type you’re looking
for.

opened and that document is in the foreground.

If you choose an existing form to import your records into, you must make sure that the first
row values match the field names exactly as you have them named in your form. Otherwise
Tap Forms will create a new field for every value in the first row which does not match a
field name in the form you’re importing into.

*
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Record navigator and “Add Missing Fields to Form”

Along the bottom of the window are a pair of arrows.

These allow you to quickly switch between records so you can make sure everything is set up quickly.

You’ll also see a check box for “Add missing fields to form”. By ticking this box, any fields that you have in
your records that aren’t currently in the form will be added – this is especially important when starting a new
form from scratch.

Last modified: Feb 07, 2020

14.2. Exporting

Whether you’d like to move your data into an Excel spreadsheet, share it with a colleague, or move into
another version of the app, Tap Forms offers export functionality that quickly converts your data into a CSV
or XLSX file. To get started, open Tap Forms, click “File”, hover over “Export”, and choose

You can also assign field types within the first row of your CSV or XLSX file by appending
the field type tag to the field name. For example: Movie Title<text>,Revenue<numbe
r>,Rating<rating>,Cover Image<photo>. If you use the Export Records feature and
enable the Export Field Type Tags option, then you’ll see Tap Forms put the field type tags
on the first row of the export file.

*
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“Records…”.

When viewing your export options, you’ll have access to a variety of customization options for your CSV file.
Although the default options may work for you, it’s important to pay attention to the settings displayed here;
without the right export selections, your file may not appear as desired in the relevant app.

On the right side of the window is the list of fields that will be included in the exported file. These will display
as the header of the columns, with the subsequent rows being filled by the content of your form. To remove
any unwanted fields from the CSV file, tap the check box next to its title.

Below is a summary of important settings when working with the export features.

File Encodings

As in the Import Records function, you can tell Tap Forms to export your file in a variety of file encodings.
UTF-8 is generally the best encoding to use as it supports encoding characters in all languages. It may
depend on the program you want to import your data into that dictates which file encoding you should use.
Check the other program to see what file encodings it supports.

Number Formats

Tap Forms can also export Number fields in a variety of different formats. For the Currency format, Tap
Forms will use your regional number format settings to determine what currency symbol to use during the
export. For example, in Canada and the USA currency numbers will be exported like $29.99, but in Europe
the same value would be exported as 29.99 €.

Export Record ID

By enabling this option, you’re telling Tap Forms to export the values that uniquely identify each record in
your form. Tap Forms will add a column called form_record_id to your CSV file. If you import a file into Tap
Forms which has a form_record_id column, it will search for matching records and update their field values
rather than adding new records to your form.

Export Linked Records

With this option enabled, Tap Forms will generate separate files containing the records from any linked
forms. If you want to import these files into another copy of Tap Forms, make sure you import the parent
form’s CSV file first and then import the child records. This way, Tap Forms will be able to join up all the
child records to the parent records.

Field Type Tags

By turning on Field Type Tags, you’re telling Tap Forms to generate a header row that contains a tag that
identifies the field’s type.
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The following are the tags that Tap Forms will generate

Tag Field Type

<text> Text

<number> Number

<date> Date

<time> Time

<date_time> Date & Time

<check_mark> Checkmark

<contact> Contact

<web_site> Website

<note> Note

<photo> Photo

<audio> Audio Recording

<phone> Phone Number

<rating> Rating

<location> Location

<email> Email Address

<calc> Calculation

<file> File Attachment

<form> Link to Form

<draw> Drawing

<section> Section Heading

<date_created> Date Created

<date_modified> Date Modified

For example, a CSV export file of a movie library form would look something like this:

Movie
Title<text>

,
Release
Year<number>

, Synopsis<note> , I Watched This<check_mark>

Terminator , 1991 , The cyborg who once tried , 1
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2:
Judgement
Day

to kill Sarah Connor is
dead, and another T-101
must now protect her
teenage son, John Connor,
from an even more powerful
and advanced Terminator,
the T-1000.

Export Media

When you enable this flag, Tap Forms will generate a zip file that contains your records in CSV files and
also a folder within the zip file that contain all of the media referenced in your records. Each media type will
have a separate folder named with the name of the form being exported and the media type. For example
“My Work Expenses-Photos”, “My Work Expenses-Files”, etc.

Last modified: Feb 20, 2019

14.3. Bento Template Importer
Tap Forms for Mac includes a Bento Template Import command to help you migrate from Bento to Tap
Forms. Bento has been discontinued by FileMaker and is not fully compatible with macOS High Sierra or
newer.

For those migrating to Tap Forms from Bento, these term differences may help you to better understand
how Tap Forms compares to Bento:

Bento Term Tap Forms Term

Library Folder Category

Library Form

Record Record

Tap Forms will import Bento 3.0 to 4.1 version templates. However, you will need version
4.0 or higher of Bento in order to be able to export your Bento data along with your
templates. One other caveat is that if you’re using a version of macOS higher than
Mavericks, you may experience an issue where Bento says “Upgrading Database” but never
completes the job if you’re upgrading from Bento 3. If this happens to you, you will need to
find an older version of macOS to perform your upgrade. Alternatively, send a Bento 3
backup file to support@tapforms.com and I’ll covert it for you. I have a copy of macOS
10.9.5 Mavericks running inside a Parallels Desktop virtual machine that I use for this
process. If you need the 30 day trial version of Bento 4.1.2 in order to convert your data,
please email me.

!
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Field Field

Form Custom Layout

Smart List Saved Search

To import your Bento template in Tap Forms:

1. Launch Bento and select your library.
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2. Select Export… from the File menu and choose the Template option.

Make sure you click on each related library displayed in the “Include these related libraries” list if you want
Tap Forms to be able to join your related forms together. Also click on “Include records in template” if you
want Tap Forms be able to import your Bento data also.

Click the Next... button to proceed.

If you don’t see the “Include records in template” option, then you’re not using the latest
version of Bento. You’ll need to download that first before proceeding. The link is at the top
of this page.

!

If you have any encrypted fields in Bento, you will need to change those in Bento first to
unencrypted Text fields before you export the template. The encrypted fields will not import
into Tap Forms.
*
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3. Save your template.

4. Launch Tap Forms, create a new empty document or open an existing
document you’re using, and select the “Import Bento Template” command from
the File menu and select your Bento template file.

Click the Choose button when you’ve found your Bento template.

Tap Forms will now import your template and records.

If your template contains more than one related form, Tap Forms will automatically create a new category
for you and put your related forms together inside that category. The category will be given a name based

If the Import Bento Template option is greyed out, please make sure you have a document
already opened and that document is in the foreground.*
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upon the file name of the template you are importing.

You will need to expand the category to view the forms by clicking on the triangle just to the left of the
category name.

Last modified: Nov 15, 2018

14.4. Bento Fields in Tap Forms
The following table describes how Tap Forms imports Bento forms and fields. Field types not on this list are
not supported in Tap Forms.

Bento Tap Forms

Once you’ve imported your Bento template, you can click on any of the layouts that Tap
Forms generated from the Bento library. You may need to reposition some elements and/or
make some adjustments to the font sizes and styles. Also, the Date Created and Date
Modified fields are usually the first fields that get imported, so if you don’t want them there,
you can just delete them in Tap Forms or move them down the list of fields in your form.
Otherwise they’ll be the first two fields which show up in the records list view.

*

Note: Tap Forms 5.2 now supports importing Bento’s Simple List field type.!
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Form

A Bento form is converted to a Tap Forms
layout. Once you’ve imported a Bento
template, you can further customize the
layout in Tap Forms or add additional
layouts to meet your needs.

Text

Bento text fields can be one or more lines
long. Tap Forms has 2 different text field
types.

• Text fields are used for shorter
one-line bits of information, such
as a Movie Title.

• Note fields are used for larger
amounts of text, such as a Movie
Synopsis.

• Tap Forms will convert Bento text
fields into Text or Note fields
depending on the height of the field
in the Bento form.

• Tall fields in Bento will be
converted to Note fields in Tap
Forms.

• Small fields in Bento will be
converted to Text fields in Tap
Forms.

Number
Bento Number fields are converted to
Number fields in Tap Forms. The Number
Formatter is set to Decimals.

Currency

Bento Currency fields are converted to
Number fields in Tap Forms. The Number
Formatter is set to Currency and the
Decimal Places is set to 2. Note: Tap
Forms supports only the currency that you
have by default according to the system’s
regional settings. For example, in Canada,
all currency values will be in CAD. In the
UK, all currency values will be in GBP.

Counter
Counter fields are converted to Number
fields.

Duration
Duration fields are converted to Number
fields with the Number Formatter set to
“hours, mins”.
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Rating
Rating fields are converted to Tap Forms
Rating fields.

Dates and Times

Times are converted to Time fields. Dates
are converted to Date fields. If the Date
field has the flag to show the Time set,
then it’s converted to a Tap Forms Date &
Time field.

Media
Media fields are converted to Photo fields.
The photo file is also extracted and copied
into the Tap Forms Photos folder.

Checkbox
Checkbox fields are converted to
Checkmark fields.

Choice

Choice fields are converted to Text fields.
The values in the Choice field are
converted to a Pick List and associated
with the Text field.

Calculation

Calculation fields are converted to
Calculation fields. Tap Forms makes a best
guess at trying to convert the Bento
formula to a Tap Forms formula, but it’s not
going to be very accurate since Bento
supports more calculation options than Tap
Forms at this time. You will probably have
to re-do your calculation formulas after the
migration.

Location

Locations fields are converted to Location
fields. The longitude and latitude values
are also set as the location name in Tap
Forms.

Phone

Phone number lists are converted to a
Phone field in Tap Forms. Only the first
phone number is imported. All other phone
numbers in the list are ignored.

Email

Email lists are converted to an Email field
in Tap Forms. Only the first email address
is imported. All other email addresses in
the list are ignored.

URL
URL fields are converted to a Website field.
Only the first value is imported. All other
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URL values are ignored.

Related Records

Related Record fields are converted into
Link to Form fields with the Many to Many
Link Type set. Tap Forms also re-
establishes the relationship data between
forms.

File List

File List fields are converted to File
Attachment fields with the Multi-File
Enabled setting turned on. Files are copied
into the Tap Forms Attachments folder.

Simple List
Simple List fields are converted to Table
fields in Tap Forms. Table fields are
available in version 5.2 and higher.

The Bento Template Importer will be improved over time as new features are added to Tap Forms which
match some of the features previously available in Bento.

Last modified: Jun 07, 2018
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15. Tools and Shortcuts
Whether it’s keyboard shortcuts or the unique barcode functionality, Tap Forms offers multiple tools and
shortcuts for you to take advantage of.

Tools and Shortcuts

• Menu Commands
• Keyboard Shortcuts
• Barcodes
• Printing
• Send to Another Device

Last modified: Jun 07, 2018

15.1. Menu Commands
Along the top of the screen macOS sits the menu bar, which contains actions and preferences for both the
system and individual app you’re using. In Tap Forms, the menu bar offers many critical and useful
options for different app functionality.

File

Under “File”, you’ll have the ability to create a new document, open other database documents, import
and export, and backup your files in Tap Forms, among other options. This is also the location where you’ll
begin the printing process for your records.

Edit

“Edit” is the more traditional menu item, including options for copy, paste, undo, redo, delete, etc. Most of
the things found here are provided by the system.

View

Within the “View” tab are multiple ways to switch between views in Tap Forms. Also available are
shortcuts to viewing all forms, your forms, or customization options for the toolbar and Touch Bar.

Forms

“Forms” contains four options: “New Form…”, “Edit Form…”, “Duplicate Form…”, and “Delete Form…”.

Records

Similar to the “Forms” menu, “Records” is specific to the records you’ve created in Tap Forms. Deleting,
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duplicating, and editing can be done here, as well as switching between records or creating a new one.

Layout

When working with layouts, “Layout” will be your go-to location for making changes. You’ll see ways to
alter layouts, adjust what tools are displayed, and how the text looks within your layout.

Tools

“Tools” offers two shortcuts: “Edit Categories…” and “Edit Pick Lists…”. Both of these will jump you
straight into the Lists tab of Preferences.

Window

Like “Edit”, “Window” features mostly system options. However, the bottom settings are Tap Forms-
exlusive: “Database Documents” and the documents you have open at the current time.

Help

The “Help” tab offers quick access to the Tap Forms manual and screencasts. There are also
shortcuts to emailing Tap Forms support, as well as to the Twitter and Facebook pages for the app.

Last modified: Jun 07, 2018

15.2. Keyboard Shortcuts
Below is a list of the available keyboard shortcuts in Tap Forms for Mac. Though not included in the table,
Tap Forms also supports copy, paste, cut, etc.

Action Shortcut

Open ⌘ + O

Save Note ⌘ + S

Sync Now ⇧ + ⌘ + S

Close ⌘ + W

Print ⌘ + P

Paste as Plain Text ⇧ + ⌘ + V

Email Selected Addresses ⇧ + ⌘ + M

Insert Date ⌃ + D

Insert Time ⌃ + T

Tap Zapp Software Inc. Tap Forms Mac - 5.3_en

Page 138 of 158



Insert Date & Time ⌃ + ⇧ + D

Find – Form ⇧ + ⌘ + F

Find ⌘ + F

Find and Replace ⌥ + ⌘ + F

Find – Next ⌘ + G

Find – Previous ⇧ + ⌘ + G

Find – Use Selection for Find ⌃ + ⌘ + E

Find – Jump to Selection ⌘ + J

Show Spelling and Grammar ⌘ + :

Check Document Now ⌘ + ;

Emoji & Symbols ⌃ + ⌘ + ␣

All Forms ⌘ + 1

My Forms ⌘ + 2

Single Column View ⌘ + 3

Multi-Column View ⌘ + 4

Calendar View ⌘ + 5

Map View ⌘ + 6

Photo Grid View ⌘ + 7

Hide Forms List ⌘ + 8

Refresh Records List ⌘ + R

New Form ⇧ + ⌘ + N

Edit Form ⇧ + ⌘ + E

Duplicate Form ⇧ + ⌘ + D

Delete Form ⇧ + ⌘ + ⌫

New Record ⌘ + N

Edit Record ⌘ + E

Duplicate Record ⌘ + D

Delete Record ⌘ + ⌫

Advanced Find and Replace ⌃ + ⌫
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Go to – Next Record ⌘ + ]

Go to – Previous Record ⌘ + [

Go to – First Record ⇧ + ⌘ + [

Go to – Last Record ⇧ + ⌘ + ]

Go to – Parent Record ⌘ + ←

Go to – Child Record ⌘ + →

New Layout ⌃ + ⇧ + N

Edit Layout ⌃ + ⇧ + E

Delete Layout ⌃ + ⇧ + ⌫

Align Objects – Left Edges ⌥ + ⌘ + ←

Align Objects – Right Edges ⌥ + ⌘ + →

Align Objects – Top Edges ⌥ + ⌘ + ↑

Align Objects – Bottom Edges ⌥ + ⌘ + ↓

Font – Show Fonts ⌘ + T

Font – Bold ⌘ + B

Font – Italic ⌘ + I

Font – Underline ⌘ + U

Font – Bigger ⌘ + +

Font – Smaller ⌘ + –

Font – Copy Style ⌥ + ⌘ + C

Font – Paste Style ⌥ + ⌘ + V

Text – Align Left ⌘ + {

Text – Align Center ⌘ + Vertical Bar

Text – Align Right ⌘ + }

Text – Show Ruler ⌃ + ⌘ + R

Text – Copy Ruler ⌃ + ⌘ + C

Text – Paste Ruler ⌃ + ⌘ + V

Go to – Next Layout ⇧ + ⌘ + .

Go to – Previous Layout ⇧ + ⌘ + ,
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Edit Pick Lists ⌘ + L

Minimize ⌘ + M

Show Previous Tab ⌃ + ⇧ + ⇥

Show Next Tab ⌃ + ⇥

Enter Full Screen ⌃ + ⌘ + F

Database Documents ⌘ + 0

Last modified: Jun 07, 2018

15.3. Barcodes
Tap Forms can now generate and print 24 different kinds of barcodes.

The following barcode symbologies are supported:

Coda bar Code 39 modulo 43 Facing Identification Mark Pharmacode One Track

Code 11 Code 93 Interleaved 2 of 5 POSTNET

Code 128 EAN 13 ISBN QR Code

Code 39 EAN 2 Supplement ISMN Standard 2 of 5

Code 39 Full ASCII EAN 5 Supplement ISSN UPC A

Code 39 Full ASCII modulo 43 EAN 8 MSI (Modified Plessey) UPC E
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To configure your barcode:

1. Click on the Form button in the toolbar.
2. Click the Fields tab.
3. Find the field you would like a barcode generated for and click on it.
4. Click on the Display as Barcode checkbox in the field’s properties pane down below.
5. Click on the Edit Barcode button.
6. Select a barcode symbology. You can enter sample text to see how it will look.

To display your barcode:

1. Follow the instructions in the “Designing Layouts” topic to create a new custom layout.
2. Drag your barcode field into your custom layout.
3. Resize your barcode to fit the area required.

A great use of the new labels feature is to put a barcode onto a label and print them out to stick them on
anything you want barcodes on.

To print your barcodes:

1. Select the custom layout which contains your barcode.
2. Select the Print command from the File menu.
3. Click the Print button.
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If you’re printing just a single label on one page, select the Print selected records option. If you want to
print different barcodes for each label, select the Multiple records per page option for your label and then
select the Print all records option on the Print sheet.

Last modified: Jun 07, 2018

15.4. Printing
Tap Forms has 4 different ways of printing your records:

1. Record Details with the Default Layout
2. Record Details with a Custom Layout
3. Table of records in a list format
4. Labels in a grid format

To print your data, click on the File menu and then click on the Print menu item.
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1. Record Details with the Default Layout

The benefit of printing the Default Layout is that it’s quick to get a nice printed report of your record details.
Also, if a single record is quite long, Tap Forms will intelligently span the printout of the record across
multiple pages, avoiding cutting off the contents of an individual field across pages.

Initially when you display the Print sheet, it will appear with only the very basic print settings.

To see the advanced print settings, click on the Show Details button.

You can also use the Fields list to select which fields you would like to print or not print. Tap Forms will
make sure there are no gaps in the printout as you enable or disable different fields.
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The print sheet will expand to display many more options for printing, including a variety of Tap Forms
specific options.

The top area of the print sheet contain standard print settings that are available in most apps. You can
select the printer, the number of copies, which pages to print, the paper size, and the paper orientation.

The bottom area contains options specific to Tap Forms.

Most of the options in the Tap Forms area are only relevant for printing the Default Layout and the Table of
records layout. They have no effect on printing custom layouts other than the following options:

1. Print selected records – to print just the records you’ve selected in the records list view.
2. Print all records – no matter how many records are selected.
3. Print field borders – to enable or disable printing of any borders around fields in your custom layout.

2. Record Details with a custom layout

There’s not much difference in the print sheet when you’re printing a custom layout.
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3. Table of records in a list format

If you need to print multiple records per page in a list format with headers and footers, then use this print
layout. Tap Forms will print as many columns as will fit on a single page width. You can change to
landscape orientation to get more room to print additional columns. You can also enable or disable different
fields to print on the multi-column list view.

To change the field print order:

1. Select the Multi-Column list view
2. Click the select fields icon to the right of the field list
3. Drag the fields up or down to match the desired print order which will also be displayed in the Multi-

Column List View after Save is clicked.
4. Click Save to save the desired order for the Multi-Column List View and also for printing.

The field print order in the Table of records print layout is based on the order of the fields
displayed on the Multi-Column List View.*
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Most of the options on the print sheet will have some effect on the printout. For example, you can enable or
disable the printing of the form name, the date, the time, and choose whether or not you want alternating
light and dark row backgrounds for your records.

To adjust the widths of the columns for printing, click on the Fields tab on the Print panel,
double-click on each width, type in a new value, and press the Return key to accept the new
width. Tap Forms will remember the widths of the columns for the next time you print that
form.

*
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4. Labels in a grid format

Last modified: May 11, 2019
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16. Customization
Aside from the customization options found across forms, fields, and records, you can also customize
certain interface elements – the toolbar and the Touch Bar.

Customization

• Toolbar
• Touch Bar

Last modified: Jun 07, 2018

16.1. Toolbar

Along the top of the Tap Forms window is a persistent toolbar, carrying a useful set of tools that provides
easy access to important functions of the app. By default are options like the differing views, the search bar,
and the format tab, among others. However, the toolbar may not contain the perfect set of features for you,
which is why we’ve included the ability to add, remove, and rearrange it.

Under “View” is the option to “Customize Toolbar…”, which will launch you into the toolbar editor. While in
this mode, you can drag things to and from Tap Forms’ toolbar – drag up to the bar to the dropdown window
to add, while drag off the toolbar to release. You can also click and drag side to side to rearrange the tools
currently sitting on the toolbar.

On the bar is also a gray, outlined box, which acts as spacing between the options in the toolbar. To break
this up, you can use the “Flexible Space” item to add an item in the middle of a previously empty area. Also
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available to be added to the toolbar is a “Sync” button, which will automatically sync your database to your
devices.

If you’ve adjusted the toolbar to a point where you’d like to simply reset it to its default settings, drag the
default toolbar – found outlined in a black box – to the window’s toolbar. Any changes you’ve made will be
reset to the default, which you can then begin editing once again.

At the bottom of the window is a dropdown menu representing what you’d like to see on the toolbar: icons
and text, icons only, or text only. Switching between these options will change the toolbar in real time so
you’ll get an idea of the preference you like as you change. When you pick the option you like, you can
choose to use a small version of it or keep it the default.

Last modified: Jun 07, 2018

16.2. Touch Bar

For MacBook Pro laptops with the Touch Bar, Tap Forms offers quick access to multiple features via the
Touch Bar shortcuts. Included by default on the Touch Bar is:

• An add button to instantly begin creating a record
• A view switcher for swapping between Single-Column, Multi-Column, Calendar, Map, and Photo

Grid
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• A search button, which jumps to the search field for typing

After clicking into the Touch Bar preferences via View > “Customize Touch Bar…”, you’ll have the ability
to change the look of the Touch Bar. Other than the three tools mentioned above, the only thing to add
into the Touch Bar is additional space between the available options; when customizing the Touch Bar,
you’ll mostly be removing or rearranging the buttons.

Touch Bar customization features two parts: the window on the display and the options on the Touch
Bar. On the display, Tap Forms will display the available tools. To add one one of these to the Touch Bar,
click on it and drag it down to the bottom of the screen. As you drag below the display, you’ll see the
selected tool appear on the Touch Bar – position it in the appropriate location and release your click.
Similarly, move your mouse to the Touch Bar to bring tools to the top display and remove them from the
Touch Bar.

When in the editing view, the Touch Bar tools will enter a “wiggle” mode, where you can tap and drag the
options to rearrange them.

Like in many other apps and websites, the Touch Bar will also adapt to the work you’re doing. These
instances can include sharing or saving a document and changing certain colors within the interface.

Last modified: Feb 20, 2019
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17. Preferences
The Preferences is a great place to familiarize yourself with the way Tap Forms behaves. In the
“Preferences” topics, you’ll read about each option found in the section.

Preferences

• General
• Lists
• Security
• Maintenance
• Sync

Last modified: Jun 07, 2018
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17.1. General

The General section of Preferences contains a small but important set of settings to know. From small
cosmetic and functional changes to the all-important backup feature, here’s a rundown of what’s available in
the first Preferences tab.

Reset Dialog Warnings

Throughout your usage of Tap Forms, you may see an occasional dialog window with warnings. If you
choose to suppress them, they’ll only be accessible through the “Reset dialog warnings” button. By pressing
this button, you’ll see any warnings that you’ve previously suppressed.
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Ruler Units

In the Layout Designer view, you’ll have the opportunity to create a unique layout for your records. When
working, a ruler will be displayed in the interface to help you gain a better understanding of the scale and
spacing of your work. If you’d like to change the units to either centimeters, inches, picas, or points, you can
do that here.

Default Pin Map Color

Records with Location fields can be used in the Map view, placing pins on the locations you have saved in
the form. By default, the color of this pin is red; however, you can change this by either selecting from one
of the pre-assigned colors or choosing a color from a wheel.

Forms List Theme

Along the left side of a Tap Forms window sits the Forms List, which contains the categories and forms
you’ve created in the app. Like most of the interface, this sidebar is lighter element, also including a bit of
transparency. For an added point of contrast, Tap Forms offers a dark theme that solidifies the list with gray
and black colors.

Record Details View

The record details section, found in any of the five views, is the collection of data inputted into your added
fields. Without a change to the preferences, records will automatically show empty fields and be editable by
an immediate click into the details view. If you’d like to hide fields you haven’t used or add an edit or save
button to the interface, you can do that under the “Record Details View” header.

Backups

Perhaps the most important part of the General preferences, the backups section is where you’ll find
settings on how to operate Tap Forms backups. Should anything happen to your Tap Forms data, use the
Restore command in the File menu to restore your document from a previously made backup.

In the backups section, you can instruct Tap Forms to back up your data each time you quit the app, how
many backups you’d like to keep, and which folder on your drive to store your backups. If you’d prefer to
manually back up your data periodically, you can also do this here or you can use the Backup command in
the File menu.

Last modified: Jan 15, 2020

17.2. Lists
Under the Lists preference, you can edit category and pick list information. For more information about
these two options, please visit their respective articles.
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• Categories
• Pick lists

Last modified: Jun 07, 2018

17.3. Security

Tap Forms values your security, offering multiple options to keep your data safe and protected. In the case
that you’ve stored sensitive information within the app, you can choose two ways to utilize security.

Locking Tap Forms

To protect your forms from any unwanted eyes, you can choose to lock Tap Forms with a password. By
auto-lock at a user-set interval and/or a lock when the document is first opened, only a password will open
the document. To streamline the unlock process further, users with MacBook Pros outfitted with Touch ID
can use their fingerprint for entrance. It is important to know, however, that if you forget your password and
cannot login with a fingerprint, you will not be able to open the document. Because of this, we recommend
storing the password in a safe location.

Note: Locking features only work with encrypted documents.
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Encryption

Encryption is a security technique that protects your data through a unique key that is unaccessible by any
party but you. If you choose to encrypt your document, you’ll use your passcode to log in to Tap Forms.
With encryption, your database will be inaccessible to anyone else inside and outside Tap Forms.

Last modified: Jun 07, 2018

17.4. Maintenance

The Maintenance section in Preferences is home to one critical feature: compacting your database. When
you compact your database, you’ll remove any unused data and attachments no longer referenced by
records.

Although you’d think that deleting data always means removing its “space” from the app, that’s not the case;
instead, Tap Forms marks the previously owned space as available for new data, which is filled by forms
and records. While this speeds up the use of the app, it can also cause the app to grow in size if you add,

If you’ve forgotten your encryption key, launch the Keychain Access application on your
Mac, search for Tap Forms, then double-click on the Tap Forms application password entry.
Next, click on the Show password checkbox button. You’ll be asked to enter your
computer’s password; then, you’ll see your encryption key displayed. The Keychain Access
application can be found by typing Keychain Access into the Spotlight search field or by
launching it from the Utilities folder (which is inside your Applications folder) in the Finder.

*

If you’ve forgotten your encryption key and you don’t see it in the Keychain Access
application, there’s no way to recover your data. Make sure you never forget your
encryption key or you have a copy of it stored in another secure location.

!
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delete, and repeat. Do that enough and Tap Forms can swell in size – but compacting the database can
return Tap Forms to a more reasonable size.

All that’s needed to create a small Tap Forms file is to click the “Compact Database” button. To the right is
the total size of the database, which should immediately decrease after you perform the cleanup. The new
number will be displayed, and will react as you continue to add data to the app. We recommend compacting
your database periodically to keep the app clean and fast.

Last modified: Jun 07, 2018

17.5. Sync

Whether you’re working between multiple macOS devices or keeping your databases consistent from your
Mac to your iOS device, sync is a big part of Tap Forms productivity. In the Sync Preferences tab, you’ll see
each of Tap Forms’ available sync options, which include Nearby, iCloud, IBM, or Apache CouchDB. Each
of these sync possibilities is covered in detail in their respective articles under the “Syncing” category in this
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guide.

In Sync Preferences is quick access to each of these sync options, including the processes to set them up.
When you sync with one solution, Tap Forms will gray out the others to show you which option you’ve
selected. After setting up sync on one device, the process is the same on any other versions of Tap Forms
you own - navigate to the Sync portion of the app and setup your account with the same credentials.

Last modified: Jun 07, 2018
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